
A4 サイズの用紙をお使いの方へ: このドキュメントは US Letter サイズで提供されています。そのまま A4 サイズの用紙

に印刷することもできますが、下の余白が多くなります。 

ドキュメントのサイズを A4 に変更する手順:  

1. Worrd で [レイアウト] に進み、A4 サイズを選択します。 

2. 目次ページ (目次の任意の場所) に移動して F9 を押し、目次のページ番号を更新します。 

3. 最後のページ (索引の任意の場所) に移動して F9 を押し、索引のページ番号を更新します。 

4. 新しい名前でファイルを保存します。 
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チュートリアルについて 

TestComplete を用いることで、デスクトップ、Web、モバイルの 3 種類のアプリケーションをテストすることが

できます。 

 デスクトップ アプリケーション - これらのアプリケーションは、Windows オペレーティング シ

ステムが動作しているデスクトップ マシンで実行します。  

 Web アプリケーション - これらのアプリケーションは、Web ブラウザー (デスクトップ アプリ

ケーションに組み込まれた Web ブラウザーを含む) で実行します。  

 モバイル アプリケーション - これらのアプリケーションは、Android デバイスまたは iOS デバ

イスで実行します。  

このドキュメントは、初めて TestComplete を使用するユーザー向けに用意されたもので、自動テストおよび

製品の概要を紹介します。また、主なアプリケーション タイプのテストの作成方法を説明するチュートリアル

も含まれています。これらのチュートリアルをお読みになることで、デスクトップ、Web、モバイル アプリケー

ションのテストを作成、修正、実行することができます。 

 

2021.10.14 - TestComplete 15.0 

© 2021 SmartBear Software 

Translated by XLsoft Corporation. 
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自動テストおよび TestComplete について 

自動テスト 

ソフトウェア テストとは、アプリケーションを調査し、そのアプリケーション内のエラーを検出するプロセスで

す。テストと単なる調査との違いは、テストはアプリケーションの出力と期待値を比較し、アプリケーションが

期待通りに機能するかどうかの判定を含んでいることにあります。言い換えると、テスターはアプリケーション

が値のリストを表示するのを確かめるだけでなく、そのリストが適切な値を含んでいるかを検証する必要があ

ります。 

このことから、基本的なテスト シーケンスは次のようになります。 

 期待する出力の定義。 

 テスト動作の実行 (適切な入力データの付与)。 

 アプリケーション出力の収集および期待する結果 (基準データ) との比較。 

 比較に失敗した場合は、開発者またはマネージャーに通知。 

自動テストとは、若干あるいは全く人間の操作のない特別なプログラムによるソフトウェア テストの自動実行

です。自動実行によって、テスト動作を 1 つたりともスキップしないことが保障されます (これは、テスターを

退屈な同じ手順の繰り返し作業から解放します)。 

TestComplete は、テスト動作の自動化、テストの作成、基準データの定義、テストの実行、テスト結果の

記録を行うための特別な機能を提供します。たとえば、ビジュアルにテストを作成できる特別な "テストのレ

コーディング" 機能を持っています。レコーディングを開始して、テストするアプリケーションに対して、必要

とされるアクションを実行するだけで、TestComplete が自動的にすべての "記録された" アクションをテスト

に変換します。また、TestComplete は、テスト内の比較コマンドやチェックポイントの自動化を簡単にする特

別なダイアログやウィザードも含んでいます。 

テスト タイプ 

TestComplete はさまざまなテスト タイプとテスト方法 (単体テスト、機能および GUI テスト、リグレッション テス

ト、分散テストなど) をサポートしています (TestComplete ヘルプの「Different Ways of Testing」を参照)。この

チュートリアルでは、最もよく用いられる機能テストを作成します。機能テストは、アプリケーションの GUI と

その背後のシステムおよびユーザー間のインターフェイスをチェックします。アプリケーション機能が予想通

りであるか検証します。 

典型的な機能テストは、クリックやキーストロークのシミュレーション、ループ内でのテスト コマンドの実行、 

オブジェクトの内容の検証などのさまざまな動作を実行するテスト コマンドから構成されます。 

TestComplete では、機能テストはキーワード テストとスクリプトの形式で作成できます。このテストは、 

レコーディングあるいは内蔵エディターでゼロから作成することができます。キーワード テストの作成は視

覚的で、簡単であり、プログラミングの知識を必要としません。スクリプトはスクリプト コマンドの理解が必要
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になりますが、より強力で柔軟性のあるテストの作成が可能になります。TestComplete は以下のスクリプトを

サポートしています。 

• JavaScript 

• Python 

• VBScript 

• その他の言語 

馴染みのある言語でスクリプトを作成できます。サポートされている言語とスクリプト作成言語の選択方法に

ついては、TestComplete ヘルプの「Selecting the Scripting Language」を参照してください。 

このチュートリアルでは、キーワード テスト機能を使用します。 

TestComplete プロジェクトとプロジェクト項目 

TestComplete はテスト プロジェクトおよびプロジェクト スイートで動作します。プロジェクトはテスト作成の開

始地点です。プロジェクトには、テスト、チェックポイントの基準データ、テストするアプリケーションについて

の情報、その他のテスト実行に必要な項目が含まれます。プロジェクトは、テストの実行シーケンスも定義し

ます。 

1 つのプロジェクトに、テストするアプリケーションのすべてのテストを含めることができます。複雑なアプリ

ケーションの場合、アプリケーションの一部分のみでプロジェクトを作成し、他の部分は他のプロジェクトで

テストすることができます。通常は、モジュール単位でプロジェクトを作成します。 

関連するプロジェクトはプロジェクト スイートにグループ化できます。TestComplete は、新しいプロジェクトを

作成するときにプロジェクト スイートを自動的に作成します。空のプロジェクト スイートを作成してプロジェク

トを追加することもできます。 

プロジェクト項目は、さまざまなテストを実行する、あるいは実行を支援するためのプロジェクト要素です。 

プロジェクト項目以外にも、プロジェクトには、テストデータ付きの Excel や .csv ファイルのようなヘルパー 

ファイルを含めることができます。 

Project Explorer で、プロジェクト、プロジェクト スイート、プロジェクト項目を表示、管理することができます。 
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TestComplete のプロジェクト項目に関する情報は、TestComplete ヘルプの「About Project Items」を参照し

てください。 
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TestComplete ユーザー インターフェイス 

TestComplete のメイン ウィンドウのサンプル画像を次に示します。 

 

TestComplete のユーザー インターフェイスは、いくつかのパネルで構成されています。 

 [Project Explorer] (ウィンドウの左側) は、プロジェクトとプロジェクト スイートの内容を

表示します。また、テスト ログへのアクセスも提供します。 

 [Workspace] は、作業用デスクトップです。エディターを表示して、テストの作成と修正、

テスト結果の確認を行うことができます。たとえば、上記の画像では、Keyword Test エディ

ターが Workspace 内で開かれています。 

 エディターの下側には、[Test Visualizer] パネルがあり、テスト コマンドのレコーディン

グ中にテスト エンジンが撮った画像を表示します。これらの画像は、テスト コマンドが実

行する動作を理解するのに役立ちます。 

  [Watch List]、[Locals]、[Breakpoints]、[Call Stack] パネルはテストのデバッグに使用されま

す。[To Do] パネルは、実行すべきタスクを管理します。 

 [Object Browser] には、すべてのプロジェクトで利用可能なコンテンツが表示されます。

マシンに存在し、テスト エンジンで利用可能なすべてのプロセス、ウィンドウおよびコン

トロール、モバイル デバイスのリストが、アプリケーション内の実際のオブジェクト階層

と同じツリー階層で表示されます。 

テスト レコーディング中、TestComplete はこれらのオブジェクトとそのメソッドやプロパ

ティを使用します。言い換えると、Object Browser から、テストで利用可能なオブジェクト、

メソッド、プロパティと、その取得方法がわかります。詳細は、TestComplete ヘルプの

「Exploring Application Properties」を参照してください。 
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パネルの説明を表示するには、パネル内をクリックして F1 キーを押します。これにより、パネルの解説が開

きます。 

TestComplete には、ユーザー インターフェイスの外観を制御するいくつかのビジュアル テーマがあります。

たとえば、ライト (デフォルト) テーマやダークテーマなどです。テーマの切り替えは、[Tools] > [Options] 

> [General] > [User Interface] ダイアログで行います。また、TestComplete のパネルのレイアウトをカスタ

マイズすることもできます。パネルの非表示、パネルの移動、サイズの変更などを手動で行うことができます。

詳細は、TestComplete ヘルプの「Customizing TestComplete」を参照してください。 

TestComplete に特定のアクションを実行するように指示するには、メニューとツールバーを使用します。

TestComplete のメニュー サブシステムは、Microsoft Visual Studio または他の主要な Windows アプリケー

ションのメニューとツールバーに類似しています。ツールバーの位置を変更したり、メニューまたはツール

バーの項目を他に移動したり、項目を隠したり、元に戻したり、他のタスクを実行することができます。詳細に

ついては、TestComplete ヘルプの「Working With TestComplete Toolbars and Menus」を参照してください。 

TestComplete テスト オブジェクト モデル 

自動テストでは、テストするアプリケーションのオブジェクト (ウィンドウ、コントロール、Web ページ要素) に対

するユーザー  アクションをシミュレートするため、最初にオブジェクトを識別する必要があるので、

TestComplete にオブジェクトを見つける方法を指示します。TestComplete はアプリケーションの個々のウィ

ンドウやコントロールを認識でき、それらのオブジェクトへのアクセスを含むテストを提供します。 
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認識されるオブジェクトは、TestComplete の [Object Browser] パネルに表示されます。 

 

注意: この画像では、デスクトップ アプリケーションのオブジェクト モデルを使用しています。Web 

およびモバイル アプリケーションのオブジェクト モデルもほぼ同じです。 

TestComplete は、テスト オブジェクトにツリー形式のモデルを使用しています。デスクトップと Web アプリ

ケーションのツリーのルート ノードは Sys で、モバイル アプリケーションのルート ノードは Mobile です。  

Process オブジェクトは オペレーティング システムで実行中のアプリケーションに対応します。このオブ

ジェクトは、Windows ドキュメント内のプロセスのコンセプトに対応するため、ここではアプリケーションでは

なくプロセスという用語を使用しています。  
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プロセス オブジェクトの名前は、実行可能なプロセスの名前とそのインデックスから構成されています (イン

デックスはいくつかのアプリケーション インスタンスを実行している場合のみ): 

 

プロセスには、子オブジェクト (最上位ウィンドウに対応するウィンドウ) があり、子オブジェクトには、コントロー

ルに対応する子ウィンドウ オブジェクトがあります。ウィンドウやコントロールの名前は、テストするアプリケー

ションの内部メソッドやプロパティにテスト エンジンがアクセスできるかどうかに依存します。TestComplete は、

両方のタイプのアプリケーションで動作しますが、それらに異なる方法で名前を付けます。 

この構造のオブジェクトの完全な名前は長く、読みづらいため、オブジェクトに短いカスタム名を割り当てる

ことができます。C:\testing-with\object-identification\name-mapping\about.htm そうすることで、テストが分か

りやすく、保守しやすくなります。 

• ブラックボックス アプリケーション 

内部メソッドやプロパティにアクセスできないアプリケーションはブラックボックス アプリケーションと

呼ばれます。このようなアプリケーションのウィンドウの名前は、ウィンドウのクラス名、ウィンドウのテ

キストあるいはタイトル (キャプション)、インデックスから構成されます。オペレーティング システムの

観点から言えば、コントロールはウィンドウの一種なので、コントロールもウィンドウと同様に名前が

付けられます。 

file:///C:/testing-with/object-identification/name-mapping/about.htm
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 ホワイトボックス アプリケーション 

内部のオブジェクト、メソッド、プロパティに TestComplete がアクセスできるアプリケーションは、ホワ

イトボックス アプリケーションあるいは Open アプリケーションと呼ばれます。このアプリケーション

には、Object Browser 内で  アイコンが表示されます (次に示す画像を参照)。 

Open アプリケーションのウィンドウやコントロールに対して、TestComplete は ウィンドウやコントロー

ルの種類を反映した名前およびアプリケーションのソースで定義した名前を付けます。たとえば、

Microsoft WinForms ライブラリで作成された C# アプリケーションの MainForm という名前のフォー

ムの場合、TestComplete は WinFormsObject("MainForm") という名前を付けます。 

 

プロセス、ウィンドウ、コントロールの名前の付け方についての詳細は、TestComplete ヘルプの「Naming 

Objects」を参照してください。 
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注意: 可能な限り、テストにはブラックボックス アプリケーションではなく Open アプリケーションを使

用することをお勧めします。Open アプリケーションで動作させることによって、テスト エンジン

がアプリケーションの内部メソッドやプロパティにアクセスできるようになり、より強力で柔軟性

のあるテストを作成することができます。  

.NET、WPF、Visual Basic、Java、Web などのアプリケーションは、TestComplete では常に 

"Open" です。そのほかのアプリケーションは特別な方法でコンパイルが必要になることがあ

ります。これについての詳細情報は、TestComplete ヘルプの「Open Applications」を参照し

てください。 

チェックポイントと Stores 

典型的なテストでは、たくさんの比較が実行されます。たとえば、アプリケーションのデータをファイルにエク

スポートするユーザー アクションをシミュレートする場合、有効なデータがファイルに含まれるかどうかを確

認する必要があります。この確認を実行するには、その基準のコピーと結果ファイルを比較します。これは、

実行する必要がある比較の 1 つの例に過ぎません。実際のテストには、数千とまではいかなくても数百の比

較が含まれます。すべてのテスト (リグレッション、単体、機能など) は、オートメーション中に有効なリファレ

ンスを必要とします。 

TestComplete を用いることで、テストに比較コマンド (あるいはチェックポイント) を簡単に追加することがで

きます。テストのレコーディング中およびデザイン時の両方でチェックポイントを作成することができます。

TestComplete は、異なる種類のデータ (画像、ファイル、オブジェクト テキストやプロパティ、XML ドキュメン

ト、データベース テーブルなど) を比較するチェックポイントを提供します。TestComplete は、これらのチェッ

クポイントで用いる基準データを格納する Stores プロジェクト項目を含んでいます。このプロジェクト項目

は、プロジェクトと一緒に保存される比較用の画像、ファイル、その他の要素を格納します。唯一の例外は、

オブジェクト プロパティを検証するチェックポイントです (このオブジェクト プロパティの基準データはテスト

内で指定されます)。 

チェックポイントと検証用コードの作成に関する詳細は、TestComplete ヘルプの「About Checkpoints」を参

照してください。 
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デスクトップ アプリケーションのテスト 

TestCompleteは、C ++、C＃、VB.NET、Java、Delphi、C ++ Builder およびその他多くの開発ツールで作成

された 32 ビットおよび 64 ビット Windows デスクトップ アプリケーションのテストをサポートします。 

このチュートリアルは、デスクトップ アプリケーション (デスクトップ マシンで実行するアプリケーション) のテス

トの基本を説明します。これは、自動テストの一般原則に精通しており、TestComplete IDE についての最低

限の知識を持っていることを前提としています。 

 初心者の方は、上記の自動テストの紹介を読むことをお勧めします。 

このチュートリアルのセクションには、TestComplete でテスト プロジェクトを作成し、簡単なテストをレコーディ

ングおよび再生実行して、結果を分析する方法の説明が含まれています。このテストは、テストするアプリ

ケーション上のユーザー アクションをエミュレートし、データを検証します。検証用コマンドはテスト レコー

ディング中に作成されます。 

テストするアプリケーションについて 

この説明では、TestComplete に含まれるサンプルの Orders アプリケーションを使用します。このアプリケー

ションは注文 (orders) のリストを表示し、注文を追加、削除、編集、エクスポートするための特別な機能を

持っています。  

 

このアプリケーションは下記の場所にインストールされます。 

C:\Users\Public\Public Documents\TestComplete 15 Samples\Desktop\Orders 
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注意: ファイル マネージャーによっては、Public Documents フォルダーを Documents として表示す

るものがあります。 

ここでは、Visual C# で作成された Orders アプリケーションを使用します。 

 
他のコンパイラー (Delphi、C ++ Builder、Swing など) で作成された Orders プロジェクトの場

合は、Web サイトの https://support.smartbear.com/downloads/testcomplete ページから 

TestComplete Samples インストール パッケージをダウンロードして実行してください。 

1. テストの計画 

サンプルの Orders アプリケーションは、注文リストを管理します。ここでは、アプリケーションの Edit Order 

フォームが正しく機能し、注文リストのデータが変更されるかどうかをテストします。この場合、次のように定

義します。 

• テストの目的: このテストは、Edit Order フォームで変更されたデータが保存され、その変更内容が

注文リストに反映されるかどうかをチェックします。 

 テストの手順: テストでは、注文の詳細情報の変更、注文リスト内のデータの検証をシミュ

レートします。アプリケーション上のユーザー アクションをシミュレートしたテストをレ

コーディングします。簡単にするために、このテストでは 1 つの注文の 1 つのプロパティの

みを "変更" します。 

 チェックおよびテスト結果の記録: 注文への変更が正しく保存されたのであれば、注文リストに

その変更内容が反映されるべきです。これをチェックするために、今回のテストはリスト内

のデータと期待される値を比較します。テストに特別な比較コマンドを追加します。このコ

マンドは、テスト ログに比較結果を出力するので、これによって検証が成功したか失敗し

たかを確認することができます。 

TestComplete を使用したテストの計画についての詳細は、TestComplete ヘルプの「Planning Tests」を参照

してください。 

2. レコーディングについて 

TestComplete では、2 通りの方法でテストを作成することができます。 

• テストを手動で作成する - スクリプト オブジェクトまたはキーワード テスト コマンドを使用して、必要

なすべてのコマンドとアクションを入力します。このアプローチは、強力で柔軟なテストを作成する

必要があるとき、またはテストの作成で豊富な経験がある場合、役に立ちます。しかし、手動でテス

トを作成することは、多くの時間を必要とし、別の問題が生じる可能性があります。たとえば、使用す

るアプリケーション オブジェクトのクラスや名前を知っていなければなりません。 

• テストを記録する - テストを簡単に作成することができます。一度、テストするアプリケーションに対

していくつかのアクションを実行すると、TestComplete は自動的にこれらのアクションを認識し、それ

らをスクリプトまたはキーワード テスト操作に変換します。テストをビジュアルに作成し、実行したアク

https://support.smartbear.com/downloads/testcomplete/samples
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ションをスクリプトまたはキーワード テストに記録できます。これは、非常に役に立つアプローチで 

あり、テストの作成であまり経験を必要としません。 

このチュートリアルでは、TestComplete でテストを記録する方法を説明します。  

レコーディングは次の 3 つの手順を含みます。 

1. レコーディングを開始します。TestComplete のメイン メニューあるいは [Test Engine] ツールバーか

ら [Test] > [Record] > [Record Keyword Test] または、[Test] > [Record] > [Record Script] 

を選択してレコーディングを開始します。スタートページの  [Record Test] をクリックして、レコー

ディングを開始することもできます。 

さまざまな種類のテスト (キーワード テスト、スクリプト、低レベルのプロシージャー) をレコーディング

することができます。レコーディングの開始に使用するメニュー項目によって、メインのレコーディン

グするテスト (キーワード テストまたはスクリプト コード) が定義されます。そのほかのテストはそのレ

コーディングが開始された後でレコーディングされます。メインのレコーディングするテストには、 

これらのテストを実行する特別なコマンドが含まれます。 

TestComplete は、レコーディング モードに切り替わり、画面上に [Recording] ツールバーが表示さ

れます。デフォルトでは、ツールバーは折りたたまれ、レコーディング中に必要となるよく利用される

コマンドだけが表示されます。 

 

[Recording] ツールバーを展開するには、  矢印ボタンをクリックします。すると、すべてのボタンが

表示されます。 

 

このツールバーを使用して、レコーディング中に追加の動作を実行したり、レコーディングの一時停

止や停止、レコーディングするテスト タイプ (キーワード テスト、スクリプト コード、低レベルのプロ

シージャー) を変更することができます。 

2. レコーディング開始後、必要なテスト動作を実行します。テストするアプリケーションを起動し (必要

な場合)、コマンド ボタンをクリックしたり、メニュー項目を選択したり、テキストを入力するなどして使

用します。 

3. すべてのテスト動作が終了した後、[Recording] ツールバーから  [Stop] を選択し、レコーディン

グを停止します。 
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テストのレコーディングに関する詳細は、TestComplete ヘルプの「Recording in TestComplete」を参照してく

ださい。 

最初のテストのレコーディング方法は、次の「3. テストのレコーディング開始」を参照してください。 

3. テストのレコーディング開始 

1. TestComplete でプロジェクトあるいはプロジェクト スイートを開いている場合は、閉じてください。

これをするには、[File] > [Close] を TestComplete のメインメニューから選択します。 

2. TestComplete スタート ページに切り替えます。このページが隠れている場合、TestComplete の 

[Help] メニューから [Start Page] を選択します。 

 

3. スタートページで、  [Record Test] をクリックします。TestComplete は、[Record Test] ウィ

ザードを表示します。 



デスクトップ アプリケーションのテスト 

smartbear.com TestComplete by SmartBear Software 

18 

  

ウィザードの最初のページで、プロジェクトの名前、場所、テスト タイプを指定します。 

[Project name] テキスト ボックスに Orders と入力します。 

[Location] テキスト ボックスはデフォルトの値のままにします。 

テスト タイプを選択します。キーワードテストまたは JavaScript、Python スクリプト テストのいずれ

かを作成することができます。 

• キーワードテストは、マウスのクリック、テキストの入力など、ユーザーの操作を定義する

一連のキーワードです。視覚的にキーワード テストを作成します。スクリプトの知識は必

要ではありません。 

• JavaScript と Python テストは、ユーザー アクションをシミュレートする命令を含むスクリ

プト関数です。 

このチュートリアルでは、キーワード テストの作成方法を示します。[Keyword] をクリックします。 

4. [Next] をクリックします。 

ウィザードを使って、テストするアプリケーションをプロジェクトに追加するため、ウィザードで作

業を続行します。 
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4. テストするアプリケーションの定義 

各 TestComplete プロジェクトには、テストするアプリケーションのリストが含まれます。これにより、プロジェク

トで使用するアプリケーションとそのテスト設定を追跡できます。 

プロジェクトにアプリケーションを追加する方法はいくつかあります。 

• プロジェクトの作成中にこれを行うことができます。 

• これは、後で Project Explorer でいつでも行うことができます。 

• テストのレコーディング中に自動的に追加することができます。レコーダーはコマンドライン、エクス

プローラーなどからのアプリケーションの開始を検出することが可能です。 

テストする Orders アプリケーションをプロジェクトに追加します。 

1. ウィザードでは、テストするアプリケーションを選択できる 2 番目のページが表示されます。 

 

2. テストする Orderes アプリケーションは、スタンドアロンの実行ファイルとして実行される .NET ア

プリケーションなので、デスクトップ アプリケーションのカテゴリに該当します。 

[Desktop] をクリックします。 

3. Application file ボックスで、 [...] ボタンをクリックします。表示される  [Select Tested 

Application] ダイアログで、Orders 実行ファイルの場所を見つけます。以下のパスにあります。 

C:\Users\Public\Public Documents\TestComplete 15 Samples\Desktop\Orders\C#\bin\Release\Orders.exe 
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注意: ファイル マネージャーによっては、Public Documents フォルダーを Documents と

して表示するものがあります。 

4. テストの実行を成功させるには、テスト実行の開始時およびテストのレコーディングの開始時に、

テストするアプリケーションの状態が同じである必要があります。テストのレコーディングを開始

するときにテストするアプリケーションが実行されている場合、その状態は後続のテスト実行中

の状態と異なることがあります (たとえば、データが読み込まれているか、ダイアログが開いてい

るなど)。そのため、テストするアプリケーションのすべての既存のインスタンスを閉じ、テストする

アプリケーションの起動からテストをレコーディングすることを推奨します。 

TestComplete が Orders アプリケーションの既存のインスタンスをすべて自動的に再起動するよ

うにするには、[Restart application] チェックボックスを選択します。 

5. [Record] をクリックし、プロジェクトの作成を完了し、レコーディングを開始します。[Record] を

クリックし、プロジェクトの作成を完了し、レコーディングを開始します。 

5. テストのレコーディング 

 レコーディング中に TestComplete ヘルプに切り替えないでください。レコーディング エン

ジンはすべてのユーザー アクションをトレースし、レコーディングします。つまり、レコー

ディングしたテストに、この "切り替え" をシミュレートするコマンドが含まれてしまいます。

操作手順は、レコーディングを開始する前に印刷しておくことができます。あるいは、2 つ

のモニターがある場合、TestComplete ヘルプをもう一方のモニターへ移動しておくことが

できます。 

1. TestComplete は、テストのレコーディングを開始し、レコーディング モードに切り替わり、画面上に 

[Recording] ツールバーが表示されます。 

 

2. レコーディングが開始されると、TestComplete は自動的にテストするアプリケーション Orders を起動

します。アプリケーションが起動しない場合は、[Recording] ツールバーの [Run App] メニューから

アプリケーションを選択して手動で起動できます。または、Windows Explorer や任意のファイル マ

ネージャーからアプリケーションを起動できます。テストするアプリケーションがリストにない場合は、

追加することができます。 

TestComplete は、特別なアプリケーションの起動テスト コマンドを使用して、アプリケーションの開

始を記録します。後でレコーディングしたテストを分析するときに、このコマンドを参照します。 
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3. アプリケーションが開始するまで待ちます。 アプリケーションのメイン ウィンドウが表示されます。 

 

4. Orders アプリケーションに切り替えて、そのメイン メニューから [File] > [Open] を選択します。 

[ファイルを開く] ダイアログが表示されます。 

5. こ の ダ イ ア ロ グで 、 MyTable.tbl フ ァ イ ルを開 き ます 。 これは 、 C:\Users\Public\Public 

Documents\TestComplete 15 Samples\Desktop\Orders フォルダーにあります。ファイル マネージャー

によっては、Public Documents フォルダーを Documents として表示するものがあります。 

 [ファイルを開く] ダイアログの [ファイル名] ボックス内には省略していないファイル

名を入力することをお勧めします。マウスを使用する代わりにキーボード入力する

ことで、異なるオペレーティング システムでテストを再生実行したり、後でテストを実

行したときに [ファイルを開く] ダイアログで異なる初期フォルダーが表示された場

合に問題を回避することができます。 
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6. [ファイル名] ボックス でファイルを指定した後、[開く] をクリックします。Orders アプリケーションは、

そのファイルからデータをロードし、アプリケーションのメイン ウィンドウにデータを表示します。 

 

7. 注文リストの Samuel Clemens 行をクリックします。 
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8. [Orders] ツールバーで、  [Edit order] をクリックします。[Orders] ダイアログが表示されます。 

 

9. ダイアログで、挿入ポイントを [Customer Name] ボックスにするため、[Customer Name] ボックス

内をクリックします。[Customer Name] ボックス内を右クリックして、コンテキスト メニューから [すべて

選択] を選択した後に顧客名として Mark Twain と入力します。 

10. [OK] をクリックしてこのダイアログを閉じます。アプリケーションのメイン ウィンドウ内の顧客リストが

更新されます。 

11. テストに比較コマンドを挿入します。この比較コマンドは、アプリケーションの顧客リストに変更した

名前 (Mark Twain) が表示されることを検証します。 

比較コマンドをチェックポイントと呼びます。TestComplete には、異なる種類のデータの検証に適し

たさまざまな種類のチェックポイントが用意されています (TestComplete ヘルプの「Checkpoints」を

参照)。最もよく使用されるチェックポイントの 1 つは、プロパティ チェックポイントです。アプリケー

ションのコントロールのデータのチェックに使用されます。このチュートリアルでは、このプロパティ 

チェックポイントを使用します。 

プロパティ チェックポイントを作成するには、Create Checkpoint ウィザードを使用するは、Quick 

Checkpoint を作成します。このチュートリアルでは、Quick Checkpoints の作成方法を示します。 
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 [Recording] ツールバーの  をクリックし、Quick Checkpoints が有効になっていること

を確認します。 

 

 マウス ポインターを顧客リストの上に移動します。TestComplete はそれを赤いフレーム

でハイライトします。  アイコンが不透明なるまで待って、マウス ポインターをそれ

に移動します。TestComplete は、Quick Checkpoints を作成するために最も一般的に使用

されるプロパティのリストを表示します。 
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 そのリストにある wItem をクリックします。このプロパティでは、ツリー表示コント

ロールの個々の項目にアクセスできます。 

 

 TestComplete は、オブジェクト プロパティのリストを表示する Create Checkpoint ウィ

ザードを開きます。このリストには、テストするアプリケーションによって定義された

プロパティと TestComplete によって提供されるプロパティが含まれます。たとえば、テ

ストするアプリケーションが C# で作成されている場合は、該当する .NET クラスのプロ

パティが含まれます。これらは、.NET カテゴリです (Available Properties テーブルを

参照)。 

クリックした wItem プロパティがハイライトされます。 
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 Mark Twain 文字列を保持しているセルを指定するには、Item ボックスに 5 を入力しま

す (5 はツリー表示での Mark Twain 項目のインデックスです。インデックスはゼロベー

スです。) 0 を SubItem ボックスに入力します。 

テスト エンジンによって項目のデータが読み取られ、プロパティ リスト内に表示されます。 

 [Condition] カラムで、デフォルトの比較条件 Equals (大文字と小文字を区別) をそのま

まにします。 

 [Value] カラムには、テスト実行中にチェックポイントが実際のデータを比較する基準

となるデータを指定します。現在の値をそのままにします。 

 プロパティのチェックボックスを選択します。 
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 [Finish] をクリックしてチェックポイント作成を完了します。 

 レコーディングしたテストにチェックポイント コマンドが追加され、そのことについて

通知が表示されます。ユーザーアクションのレコーディングを継続できます。 

12. ウィンドウのキャプション バーにある [X] ボタンをクリックして [Orders] ウィンドウを閉じます。変更を

保存するかどうかを確認するダイアログが表示されます。[いいえ] をクリックします。 

13. [Recording] ツールバーの  [Stop] を押して、レコーディングを停止します。レコーディングしたテ

スト コマンドが処理され、テストに保存されます。 
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6. レコーディングしたテストの分析 

レコーディング終了後、TestComplete はレコーディングしたキーワード テストを編集用に開き、Keyword 

Test エディターにテストの内容を表示します。 

 

レコーディングしたテストは上記の画像に示すテストのようになります。実行環境によってはこれとは異なる

ことがあります。たとえば、C++ Builder または Delphi アプリケーションでテストをレコーディングした場合は、

ほかのオブジェクト名やウィンドウ インデックスを含んでいる可能性があります。 

このテストには、レコーディング中に Orders アプリケーション上で実行した動作に対応するコマンドが含まれ

ています。このテスト コマンドを operation と呼びます。 
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コマンドの下に [Test Visualizer] パネルがあり、TestComplete によってテストのレコーディング中に 

operation でキャプチャーされた画像が表示されます。 

 

これらの画像は、レコーディングした operation を表し、operation が実行する動作を理解するのに役立ちま

す。TestComplete は、ユーザー アクション (マウス クリック、テキスト入力など) に対応した operation の画像

のみをキャプチャーします。  

エディター内でこの操作を選ぶと、Test Visualizer は自動的に適切な画像を選択するため、operation が実

行される前にアプリケーションの状態を簡単に見ることができます。画像をさらに詳しく見たい場合は、[Test 

Visualizer] パネルでその画像をダブルクリックします。  

画像の作業についての詳細は、TestComplete ヘルプの「Test Visualizer」を参照してください。 

このテストの最初の operation は、Run TestedApp です。これは、テストするアプリケーション (今回の場合、

Orders アプリケーション) を、キーワード テストから起動するのに使用します。TestComplete は、自動的にア

プリケーションを起動するときに、あるいは [Recording] ツールバーやオペレーティング システムの UI から

アプリケーションが起動されたことを検出すると、自動的にこの操作を記録します。 

 

次の operation は、[File] > [Open] メニュー項目の選択に対応します。  
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次の operation は、[ファイルを開く] ダイアログでファイルを開く動作をシミュレートします。 

 

特定のケースでは、TestComplete は、[ファイルを開く] ダイアログ コントロールを操作するときに実行するア

プションをシミュレートする一連の操作をレコーディングできます。 

注意: [ファイルを開く] ダイアログのコントロールを使用してファイルをナビゲートする代わりに、 

このダイアログの [ファイル名] ボックスに開きたいファイルのフルネームを入力することを推奨

します。そうすることで、オペレーティング システム、ダイアログで表示されるパス、利用可能な

ナビゲーション バーやパネルに関係なく、正常に実行されるテストを記録できます。  

テストに [ファイルを開く] ダイアログに対する一連の操作が含まれる場合、手動でテストを編

集して、これらの操作を OpenFile メソッドの呼び出しに置換することができます。 

その後、アプリケーションのメイン ウィンドウと Order フォームでのユーザー アクションをシミュレートする 

operation が続きます。 

 

マウス イベント、キーボード入力、スクリプトからのその他の動作についての詳細は、TestComplete ヘルプ

の「Simulating User Actions」を参照してください。 
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次は、テスト レコーディング中に追加した比較動作です。 

 

最後に、Orders アプリケーションを閉じる動作とメッセージ ボックス内で [いいえ] ボタンを押した動作です。 

 

TestComplete は、自動的に operation を使用したプロセスやウィンドウに対応するグループにまとめます。グ

ループ化することで、テスト構造を簡単に理解できるようにし、さらにアプリケーションのオブジェクト階層の

情報を提供しています。 

ここでは、1 つのプロセス (Orders) のユーザー アクションをレコーディングしました。そのため、"process" グ

ループ ノードは、1 つだけです。このグループ ノードには、プロセス ウィンドウおよびコントロールでシミュ

レートしたすべての動作が含まれています。Orders プロセスのコントロールやウィンドウで実行した動作は

いくつかの "window" グループ ノードにまとめられています。 

 

テストするプロセスやそのウィンドウ、およびコントロールの名前が、これまでの手順で [Object Browser] パ

ネルに表示されていた名前と異なることにお気付きかもしれません。たとえば、Object Browser では、テスト

するプロセスは Process("Orders") という名前であるのに対し、テスト内では Orders と呼ばれます。また 

Object Browser で、メイン ウィンドウは WinFormsObject("MainForm") と呼ばれるのに対し、テストでは 

MainForm という名前です。  

これには、論理的な理由があります。デフォルトでは、TestComplete は、テスト レコーディング中に使用し

たオブジェクトに対して自動的にカスタム ネームを生成し、使用します。カスタム ネームの生成および割り
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当ては、名前のマッピングと呼ばれます。デフォルトの名前は理解しにくいことがあるので、TestComplete 

では名前のマッピングを行っています。デフォルトの名前では、名前に対応するウィンドウやコントロール

がどれなのかの判断が難しいことがあります。マッピングした名前はテストをよりわかりやすく、安定したもの

にします。名前のマッピングに加えて、TestComplete はマップされたオブジェクトのイメージを  Name 

Mapping リポジトリに格納します。これは、1 つまたは別のマップされたオブジェクトが一致するウィンドウま

たはコントロールを理解するのに役立ちます。名前のマッピングに関する詳細情報は、TestComplete ヘル

プの「Name Mapping」を参照してください。 

7. レコーディングしたテストの実行 

TestComplete がユーザー アクションをどのようにシミュレートするか、ここで簡単なテストを実行してみま

しょう。  

レコーディングしたテストを実行する前に、レコーディングしたときと同じ初期状態でテストが開始されること

を確認してください。たとえば、ほとんどテストは、テストするアプリケーションの実行を必要とします。つまり、

ユーザー アクションをシミュレートする前に、そのアプリケーションを起動する必要があります。今回の例で

は、テストするアプリケーションを起動するため、テストの始めに Run TestedApp operation を使用し、テス

トによってアプリケーションが起動されるようにしました。代替手段として、テストするアプリケーションを手動

で TestComplete の IDE から実行することも可能です。 

レコーディングしたテストを実行するには、テスト エディターのツールバーにある  [Run Test] をクリックし

ます。 

 

このテスト エンジンは TestComplete のウィンドウを最小化して、テスト コマンドの実行を開始します。 

このチュートリアルのテストでは、レコーディングした動作が実行されます。  

注意: テスト実行中は、マウスを動かしたり、キーを押したりしないでください。TestComplete でシ

ミュレートされる動作を妨げたり、テスト実行が正しく行われない可能性があります。 

テスト実行の終了後、TestComplete はテスト結果を表示します。次の手順では、これを分析します。 

テスト実行に関するいくつかの注意: 

 作成したテストは、テスト実行用の実行ファイルにはコンパイルされません。TestComplete 

から直接テストを実行します。TestComplete がインストールされていないマシンでテストを

実行するには、TestExecute と呼ばれるリソース フレンドリーなユーティリティを使用する

ことができます。また、外部のアプリケーションにスクリプトをエクスポートして、それを
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実行することもできます。詳細については、TestComplete ヘルプの「Connected and Self-Testing 

Applications」を参照してください。 

 テストの実行中、TestComplete は、画面の右上にインジケーターを表示します。  

 

このインジケーターは、シミュレートしたテスト動作に関する通知メッセージを表示します。 

 TestComplete は、テストが終了するまでこのテスト コマンドを実行します。[Test Engine] 

ツールバーの  [Stop] を押すか、または TestComplete メイン メニューから [Test] > [Stop] 

を選択することで、テスト実行をいつでも停止することができます。  

 [Pause] をクリックすることでテスト実行を一時停止することができます。一時停止の間は、必要

な任意の動作を実行することが可能です。たとえば、テスト ログを表示したり、TestComplete の 

[Watch List] や [Locals] パネルあるいは [Evaluate] ダイアログを使用してテストの変数やオブ

ジェクトを確認することが可能です (TestComplete ヘルプの「Debugging Tests」を参照)。 

 テストを実行するには、テスト エディターのツールバーにある [Run Test] ボタンを使用し

ま す 。 

このほかにも、いくつかの方法でテストを実行することができます。Project Explorer あるい

は、ほかのテストから、テストを実行することも可能です。プロジェクト エディターのテ

スト項目ページを使用して、バッチの実行を作成することもできます。 

TestComplete のテスト実行、実行に影響するプロジェクト設定、テスト実施に関する詳細は、TestComplete 

ヘルプの「Running Tests」を参照してください。 
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8. テスト結果の分析 

TestComplete は、テスト中に実行されたすべての操作の完全なログを保存します。テスト結果へのリンクは、

[Project Explorer] パネルの [Project Suite Logs] > [Orders Log] ノードに表示されます。これは、プロ

ジェクトおよびプロジェクト スイートのテスト履歴を調べるための主なワークスペースです。各ノードは 1 つの

テスト実行に対応します。ノードの左の画像は、対応するテストの実行が成功したかどうかを表しています。 

 

テスト実行の終了後、TestComplete は自動的に最終結果のノードを追加します。つまり、テストが実行中のと

きは、結果は表示されません (テストの実行を一時停止した場合は、中間結果を表示することができます)。 

ここまでに実行したテストは 1 つのみなので、Project Explorer には 1 つのログ ノードだけが表示されます。

デフォルトでは、[Workspace] パネルにこのノードの内容が自動的に表示されます。このログは、いつでも

確認することができます。ログを見るには、[Project Explorer] パネルで表示したい結果を右クリックし、コン

テキスト メニューから [Open] を選択します。 

注意: デフォルトで、TestComplete はログ ファイルにすべてのテスト結果を格納します。テスト実行

ごとにログ ファイル数が増えて、メモリ消費量が増加します。メモリ使用量を減らすために、

手動でログ ファイルを削除したり、保存するログ ファイルの数を制限することができます。 
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この例では、ログは次のようになります。 

 

ログ ウィンドウは、1 度に 1 つのテスト実行の結果を表示します。ウィンドウの左側は、実行されたテストのツ

リー構造で、それぞれのテストのノードを選択してその結果を表示することができます。たとえば、今回の例

のように 1 つのテストを実行した場合、このツリーには 1 つのノードのみ含まれます。このノードのアイコンは、

テストが成功したかどうかを示します。 

テスト ログには、エラー、警告、情報および他の種類のメッセージが含まれています。左のアイコンは、 

メッセージの種類を示します。メッセージ リストの上のチェック ボックスを使用することで、種類によってメッ

セージを表示/非表示にすることができます。 

それぞれのメッセージでは、アクションが行われた時間が Time 列に表示されます。 

TestComplete は、メッセージとともに追加テキストや画像を出力することがあります。これらを確認するには、

ログ内でメッセージを選択し、メッセージ リストの下にある [Details] や [Picture] ペインを参照します。 

たとえば、上記画像の [Picture] ペインは、"The menu item 'Orders|Edit order...' was clicked" メッセージに関

連するスクリーンショットを表示しています。 

[Picture] パネルでは、選択したテスト コマンドを実行する前に、期待される状態と実際のアプリケーション

の状態を示す画像が表示されます("期待される" とはレコーディング中にそのテスト コマンドでキャプチャー

された画像を指し、"実際" とはテストの実行中にキャプチャーされた画像を指します)。画像の違いを見るた
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め、  [View Comparison Result] をクリックすることができます。そのため、テストでエラーが発生した場

合、簡単に見つけることができます。詳細については、TestComplete ヘルプの「Test Visualizer」を参照して

ください。  

ログにメッセージを出力したテスト操作を表示するには、ログ内でメッセージをダブルクリックします。すると、

エディターでキーワード テストが開き、該当する操作がハイライトされます。たとえば、ログの "Toolbar button 

5 was clicked" メッセージをダブルクリックした場合、この動作が行われたキーワード テスト操作がハイライト

されます。 

 

テスト ログ パネル、ログへメッセージを出力、その結果の使用に関する詳細情報は、TestComplete ヘルプ

の「Test Results」を参照してください。 

注意: ここで説明したログは、TestComplete キーワード テストおよびスクリプト特有のログです。 

ほかの種類のテストは異なった構造のログになります。ログに関する詳細情報は、適当なプ

ロジェクト項目の解説を参照するか、そのログ ページ内をクリックして、F1 を押してください。  

エラーの解決 

テストが失敗することがあります。これにはいくつかの可能性があります。たとえば、開発者がアプリケーショ

ンの振る舞いを変更したり、ウィンドウとコントロールの認識属性の変更によりテスト エンジンが必要なオブ

ジェクトの検出に失敗したり、サードパーティのアプリケーションがテストするアプリケーションのウィンドウに

重なっているためにテスト エンジンがアクションのシミュレートに失敗するなどの可能性があります。 
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初めてのユーザーが直面する最も典型的なものは、テスト作成中と再生実行中でアプリケーションの状態

が異なることです。この問題を避けるには、テストを作成したときと同じ初期状態でテスト実行しているか確

認してください。たとえば: 

• テストするアプリケーションがテストを記録する前に実行されていた場合は、テストを実行する前に

実行している必要があります。 

• テストアクションがアプリケーションの特定のウィンドウで実行された場合は、テストを実行するときに

もそのウィンドウを開く必要があります。 

• アプリケーション内のデータを編集して保存した場合は、変更を元に戻す必要があります。 

テストするアプリケーションが変更され、テストするオブジェクトの検出に使用される識別プロパティが無効に

なると、TestComplete は不足オブジェクトを見つけるため変更の検出を試みます。テスト ログが "Object 

<Object_Name> was replaced with a similar object" 警告を報告した場合、TestComplete はテストの実行中に

テストするオブジェクトを見つけることができず、代わりに類似するオブジェクトを使用したことを意味します。 

 

この警告は無視しないでください。不足オブジェクトと代替オブジェクトを確認して、問題を解決するためオ

ブジェクトの識別プロパティを更新してください。 

エラーの原因を探し、典型的な問題を解決するための情報は、TestComplete ヘルプの「Handling Playback 

Errors」を参照してください。 
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Web アプリケーションのテスト - チュートリアル 

TestComplete は、Internet Explorer、Edge、Chrome、Firefox、または組み込みの  WebBrowser または 

Chromiumで動作する Web アプリケーションの機能テストをサポートします。TestComplete は、Web アプリ

ケーションのテストをサポートし、HTML5、AJAX、ASP.NET、Flash、Flex、AIR、および Silverlight テクノロ

ジーのサポートを強化しています。 

このセクションでは、TestComplete でテスト プロジェクトを作成し、簡単な Web テストをレコーディング、再生

実行し、結果を分析する方法について説明します。これは、自動テストの一般原則に精通しており、

TestComplete IDE についての最低限の知識を持っていることを前提としています。 

 初心者の方は、上記の自動テストの紹介を読むことをお勧めします。 

このテストは、Web ページ上のユーザー アクションをエミュレートし、データを検証します。検証用コマンド

はテスト レコーディング中に作成されます。 

テストする Web ページについて 

このチュートリアルでは、SmartBear 社の Web サイトにあるサンプルの SmartStore アプリケーションを使用し

ます。 

https://services.smartbear.com/samples/TestComplete14/smartstore/ 

https://services.smartbear.com/samples/TestComplete14/smartstore/
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このアプリケーションは、アイテムをブラウズしたり、ウィッシュ リストとショッピング カートに追加したり、アイテ

ムを比較したりできるサンプル オンライン ストアです。アカウントを作成して、ログインし、モックアップ オー

ダーを作成することができます。 

 

注意: このチュートリアルでは、Google Chrome Web ブラウザーを使用します。チュートリアルのすべの

画像は、テストするアプリケーションを Chrome で開いた状態で作成されています。サポートされて

いる任意の Web ブラウザーを使用できます。 

1. Web ブラウザーの準備 

TestComplete で Web テストをレコーディングして再生実行するには、Web ブラウザーを特別な方法で設定

する必要があります。また、クロスブラウザー テストを簡単にするため、ブラウザー固有の動作を排除するこ

とを推奨します。ブラウザーの設定についての詳細は、TestComplete ヘルプの「Preparing Web Browsers」

を参照してください。 

ブラウザーの設定が完了したら、テストを作成します。 
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2. テストの計画 

このサンプル SmartStore アプリケーションは、オンライン ストアです。アプリケーションがショッピング カート

にアイテムを正しく追加するかどうかをテストする必要があるとします。この場合、次のように定義する必要が

あります。 

 テスト目的: テストでは、選択したアイテムがショッピング カートに正しく追加されている

かどうかを確認する必要があります。つまり、ショッピングカートに追加されたアイテムが

表示されます。 

 テスト手順: テストでは、ショッピング カートにアイテムを追加し、ショッピング カートに

このアイテムが含まれていることを確認する必要があります。アプリケーション上のユー

ザー アクションをシミュレートしたテストをレコーディングします。 

 テスト結果の確認とロギング: アイテムが正しく追加されている場合は、そのアイテムが

ショッピング カート内にある必要があります。これをチェックするには、ショッピング カー

トのデータの期待値を比較します。この目的のために、特別な比較コマンドをテストに追加

します。このコマンドは、比較結果をテストログに出力するので、検証が失敗したかどうか

を見れます。  

TestComplete を使用したテストの計画についての詳細は、TestComplete ヘルプの「Planning Tests」を参照

してください。 

3. テストのレコーディングについて 

TestComplete では、2 通りの方法でテストを作成することができます。 

• テストを手動で作成する - スクリプト オブジェクトまたはキーワード テスト コマンドを使用して、必要

なすべてのコマンドとアクションを入力します。このアプローチは、強力で柔軟なテストを作成する

必要があるとき、またはテストの作成で豊富な経験がある場合、役に立ちます。しかし、手動でテス

トを作成することは、多くの時間を必要とし、別の問題が生じる可能性があります。たとえば、使用す

るアプリケーション オブジェクトのクラスや名前を知っていなければなりません。 

• テストを記録する - テストを簡単に作成することができます。一度、テストするアプリケーションに対

していくつかのアクションを実行すると、TestComplete は自動的にこれらのアクションを認識し、それ

らをスクリプトまたはキーワード テスト操作に変換します。テストをビジュアルに作成し、実行したアク

ションをスクリプトまたはキーワード テストに記録できます。これは、非常に役に立つアプローチであ

り、テストの作成であまり経験を必要としません。 

このチュートリアルでは、TestComplete でテストを記録する方法を説明します。  

レコーディングは次の 3 つの手順を含みます。 

1. レコーディングを開始します。TestComplete のメイン メニューあるいは [Test Engine] ツールバーか

ら [Test] > [Record] > [Record Keyword Test] または、[Test] > [Record] > [Record Script] 

を選択してレコーディングを開始します。スタートページの  [Record Test] をクリックして、レコー

ディングを開始することもできます。 
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さまざまな種類のテスト (キーワード テスト、スクリプト、低レベルのプロシージャー) をレコーディング

することができます。レコーディングの開始に使用するメニュー項目によって、メインのレコーディン

グするテスト (キーワード テストまたはスクリプト コード) が定義されます。そのほかのテストはそのレ

コーディングが開始された後でレコーディングされます。メインのレコーディングするテストには、 

これらのテストを実行する特別なコマンドが含まれます。 

TestComplete は、レコーディング モードに切り替わり、画面上に [Recording] ツールバーが表示さ

れます。デフォルトでは、ツールバーは折りたたまれ、レコーディング中に必要となるよく利用される

コマンドだけが表示されます。 

 

[Recording] ツールバーを展開するには、  矢印ボタンをクリックします。すると、すべてのボタンが

表示されます。 

 

このツールバーを使用して、レコーディング中に追加の動作を実行したり、レコーディングの一時停

止や停止、レコーディングするテスト タイプ (キーワード テスト、スクリプト コード、低レベルのプロ

シージャー) を変更することができます。 

2. レコーディング開始後、必要なテスト動作を実行します。テストするアプリケーションを起動し (必要

な場合)、コマンド ボタンをクリックしたり、メニュー項目を選択したり、テキストを入力するなどして使

用します。 

3. すべてのテスト動作が終了した後、[Recording] ツールバーから  [Stop] を選択し、レコーディン

グを停止します。 

テストのレコーディングに関する詳細は、TestComplete ヘルプの「Recording in TestComplete」を参照してく

ださい。 

4. テストのレコーディング開始 

1. TestComplete でプロジェクトあるいはプロジェクト スイートを開いている場合は、閉じてください。 

これをするには、[File] > [Close] を TestComplete のメインメニューから選択します。 
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2. TestComplete スタート ページに切り替えます。このページが隠れている場合、TestComplete の 

[Help] メニューから [Start Page] を選択します。 

 

3. スタートページで、  [Record Test] をクリックします。TestComplete は、[Record Test] ウィザー

ドを表示します。 

  

4. ウィザードの最初のページで、プロジェクトの名前、場所、テスト タイプを指定します。 
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[Project name] テキスト ボックスに Orders と入力します。 

[Location] はデフォルトの値をそのままにします。 

テスト タイプを選択します。キーワードテストまたは JavaScript、Python スクリプト テストのいずれかを

作成することができます。 

• キーワードテストは、マウスのクリック、テキストの入力など、ユーザーの操作を定義する一連の

キーワードです。視覚的にキーワード テストを作成します。スクリプトの知識は必要ではありま

せん。 

• JavaScript と Python テストは、ユーザー アクションをシミュレートする命令を含むスクリプト関数

です。 

このチュートリアルでは、キーワード テストの作成方法を示します。[Keyword] をクリックします。 

5. [Next] をクリックします。 

ウィザードを使って、テストするアプリケーションをプロジェクトに追加するため、ウィザードで作業を続行し

ます。 

5. テストする Web ページの定義 

1. ウィザードでは、テストするアプリケーションを選択できる 2 番目のページが表示されます。 

 

2. Web ページにある SmartStore アプリケーションをテストするので、[Web] をクリックします。 
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3. サポートしている Web ブラウザーの 1つを選択します。 

• Internet Explorer 

• Firefox 

• Google Chrome 

• Microsoft Edge 

注意: 
TestComplete は Edge Chromium のみサポートします。古いバージョンの Edge で

はレコーディングを利用できません。 

このチュートリアルでは Google Chrome を使用します。サポートされているその他の Web ブラウ

ザーを使用できます。 

4. [URL] テキスト ボックスで、次の URL を入力します。 

https://services.smartbear.com/samples/TestComplete14/smartstore/ 

5. テストを正常に実行するには、テスト実行の開始時にテストするアプリケーションの状態をテストのレ

コーディング時の開始時と同じにする必要があります。テストのレコーディングを開始するときにテス

トするアプリケーションが実行されている場合、その状態は後続のテスト実行中の状態と異なること

があります (たとえば、データが読み込まれているか、ダイアログが開いているなど)。そのため、テス

トのレコーディングを開始する前に、Web ブラウザーの実行中のすべてのインスタンスを閉じること

をお勧めします。 

サポートされている Web ブラウザーのいずれかが実行されている場合、ウィザードは、[Restart 

the selected browser] チェックボックスを表示します。このチェックボックスをオンにすると、選択

した Web ブラウザーを閉じて、レコーディングが開始されると自動的に再起動するようにウィザード

に指示します。 

(システム内で他の Web ブラウザーが実行されている場合、Web ブラウザーは引き続き実行され

ます。) 

6. [Use XPath and CSS selectors for web objects] チェックボックスをオンにすると、CSS セレク

ターの XPath 式を使用して Web オブジェクトを識別できます。 

これはクロスプラットフォーム Web テストでは必須です。これらのテストは、Safari と MacOS など、

リモート環境のさまざまな Web ブラウザーとプラットフォームで実行できます。そのようなテストの作

成は、このチュートリアルではカバーしませんが、 

このチェックボックはオンにしたままにすることを推奨します。 

7. [Record] をクリックし、プロジェクトの作成を完了し、レコーディングを開始します。 
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6. テストのレコーディング 

注意: レコーディング中に TestComplete ヘルプに切り替えないでください。レコーディング エンジン

はすべてのユーザー アクションをトレースし、レコーディングします。つまり、レコーディングし

たテストに、この "切り替え" をシミュレートするコマンドが含まれてしまいます。  

操作手順は、レコーディングを開始する前に印刷しておくことができます。あるいは、2 つのモ

ニターがある場合、TestComplete ヘルプをもう一方のモニターへ移動しておくことができま

す。 

1. 選択した Web ブラウザーが起動し、SmartStore アプリケーションのメインページに移動するまで待

ちます。 

 

ブラウザーが起動しない場合は、起動して必要な Web ページを手動で開くことができます。 

TestComplete は、特別なテスト コマンドを使用して、Web ブラウザーの開始をレコーディングします。

後でレコーディングしたテストを分析するときに、このコマンドを参照します。 
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2. [検索] テキスト ボックスに、ball を入力します。 
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3. 検索結果で、Official game ball アイテムを見つけて、クリックします。 
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4. アプリケーションが、選択したアイテムページを開きます。 
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5. そのページで、アイテムのカラー: 青色と、サイズ: 3 を選択します。 

 

6. [Add to cart] をクリックします。 
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7. アプリケーションの Shopping Cart にアイテムが追加されます。 

 

8. テストに比較コマンドを挿入します。ショッピングカートに選択した機能 (カラー: 青色、サイズ: 3) の

アイテムが含まれていることが確認されます。 

比較コマンドをチェックポイントと呼びます。TestComplete には、異なる種類のデータの検証に適し

たさまざまな種類のチェックポイントが用意されています (TestComplete ヘルプの「Checkpoints」を

参照)。最もよく使用されるチェックポイントの 1 つは、プロパティ チェックポイントです。アプリケー

ションのコントロールのデータのチェックに使用されます。このチュートリアルでは、このプロパティ 

チェックポイントを使用します。 

プロパティ チェックポイントを作成するには、Create Checkpoint ウィザードを使用するは、Quick 

Checkpoint を作成します。このチュートリアルでは、Quick Checkpoints の作成方法を示します。 

 [Recording] ツールバーの  をクリックし、Quick Checkpoints が有効になっていることを

確認します。 

 

 マウスポインターを Color: Blue, Size:3 の行に移動します。TestComplete はそれを赤いフ

レームでハイライトします。  アイコンが表示されるまで待ち、マウスポインターをその

アイコンに移動します。TestComplete は、Quick Checkpoints を作成するために最も一般的に

使用されるプロパティを表示します。 
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 リストで、[contentText] プロパティを選択します。 
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このプロパティは、選択した Web 要素が表示するテキストへのアクセスを提供します。この

プロパティは、ブラウザーに依存しません。つまり、サポートされているすべての Web ブラウ

ザーで同じように動作し、さまざまなブラウザーでテストを実行再生する際の問題を回避で

きます。 

 TestComplete は、レコーディングしたテストにチェックポイント コマンドを追加し、それ

に関する通知を表示します。 

 ユーザーアクションのレコーディングを継続できます。 
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9. アイテムの横にある [削除] ボタンをクリックし、ショッピングカートをクリアします。 

 

10. ブラウザーのキャプション バーにある [X] ボタンをクリックしてブラウザーを閉じます。 

11. [Recording] ツールバーの  [Stop] を押して、レコーディングを停止します。レコーディングしたテ

スト コマンドが処理され、テストに保存されます。 
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7. レコーディングしたテストの分析 

レコーディング終了後、TestComplete はレコーディングしたキーワードを Keyword Test エディターで開き

ます。 

 

レコーディングしたテストは上記の画像に示すテストのようになります。実行環境によってはこれとは異なる

ことがあります。たとえば、不要なクリック操作が含まれていることがあります。 

このテストには、レコーディング中に SmartStore アプリケーション上で実行した動作に対応するコマンドが含

まれています。このテスト コマンドを operation と呼びます。 

コマンドの下に [Test Visualizer] パネルがあり、TestComplete によってテストのレコーディング中に 

operation でキャプチャーされた画像が表示されます。 
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これらの画像は、レコーディングした operation を表し、operation が実行する動作を理解するのに役立ちます。

TestComplete は、ユーザー アクション (マウス クリック、テキスト入力など) に対応した operation の画像のみを

キャプチャーします。エディター内でこの操作を選ぶと、Test Visualizer は自動的に適切な画像を選択する

ため、operation が実行される前にアプリケーションの状態を簡単に見ることができます。画像の作業につい

ての詳細は、「Test Visualizer」を参照してください。 

このテストの最初の operation は、Run Browser です。これは、ブラウザーを起動し、キーワード リストから

指定されたページに移動します。TestComplete は、ブラウザーが起動されたことを検出すると、自動的にこ

の操作をレコーディングします。 

 

次の動作は、検索ボックスと検索結果に連動します。 

 

次に、選択されたアイテムの説明を持つページを待つ動作があります。 

 

それに続いて、アイテムの色とサイズを選択し、そのアイテムをカートに追加する動作があります。 

 

次は、テストのレコーディング中に追加した比較動作です。 
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その後、ショッピングカートをクリアする動作があります。 

 

そして、Web ブラウザーを閉じる動作です。 

 

マウス イベント、キーボード入力、スクリプトからのその他の動作についての詳細は、TestComplete ヘルプ

の「Simulating User Actions」を参照してください。 

TestComplete は、自動的に operation を使用したプロセスやウィンドウに対応するグループにまとめます。 

グループ化することで、テスト構造を簡単に理解できるようになります。さらにアプリケーションのオブジェクト

階層の情報を提供しています。 

ここでは、1 つのブラウザーのユーザー アクションをレコーディングしました。そのため、ブラウザーのグルー

プ ノードがあります。これらには、ブラウザー ウィンドウおよびコントロールで実行したすべての動作が含ま

れています。さまざまな Web ページで実行した動作はいくつかの "page" グループ ノードにまとめられてい

ます。 
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 レコーディングしたテストの Web ブラウザー、およびページ要素の名前に注意する必要があります。 

 

これらは、[Object Browser] パネルに表示される名前と異なります。たとえば、[Object Browser] では、

Web ブラウザーの名前は  (使用するブラウザーに応じて ) Browser("iexplore")、Browser("edge")、

Browser("firefox")、または Browser("chrome") であるのに対し、テストでは単に browser と呼ばれます。

別 の 例 は 、 SmartStore ア プ リ ケ ー シ ョ ン の メ イ ン ペ ー ジ で す 。 Object Browser で は 、

Page("https://services.smartbear.com/samples/TestComplete14/smartstore/") と呼ばれ、テストでは、

その名前ははるかに短い pageShop と呼ばれます。 

これは、デフォルトで、テストをレコーディングしている間、TestComplete は自動的にすべての項目を 

Name Mapping リポジトリに追加しているためです。項目ごとに、TestComplete は後でアプリケーション内

のオブジェクトを見つけるために使用する認識パラメーターと、alias を格納します。alias はテスト内のオブ

ジェクトを見つけるために使用する短い名前です。 
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Project Explorer の  Name Mapping 項目をダブルクリックして、Name Mapping リポジトリを開き、

TestComplete がテストのレコーディング中にオブジェクト用に作成した認識パラメーターと alias を表示でき

ます。 

 

Name Mapping と alias の使用は、テストをより分かりやすく、安定したものにします。 

8. レコーディングしたテストの実行 

TestComplete がユーザー アクションをどのようにシミュレートするか、ここで簡単なテストを実行してみま

しょう。 

レコーディングしたテストを実行する前に、初期状態がレコーディングしたときと同じであることを確認してく

ださい。たとえば、ほとんどの Web テストでは、Web ブラウザーが起動され、必要なページが表示されてい

る必要があります。今回の例では、ブラウザーを起動し、テストする Web ページを開くため、テストの初めに 

Run Browser operation を使用します。 

レコーディングしたテストを実行するには、テスト エディターのツールバーにある  [Run Test] をクリックし

ます。 
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TestComplete がテスト コマンドの実行を開始します。このチュートリアルのテストでは、レコーディングした動

作が実行されます。 

注意: テスト実行中は、マウスを動かしたり、キーを押したりしないでください。TestComplete でシ

ミュレートされる動作を妨げたり、テスト実行が正しく行われない可能性があります。 

テスト実行の終了後、TestComplete はテスト結果を表示します。次の手順では、これを分析します。 

テスト実行に関するいくつかの注意: 

 テストの実行中、TestComplete は、画面の右上にインジケーターを表示します。  

 

このインジケーターは、シミュレートしたテスト動作に関する通知メッセージを表示します。 

 TestComplete は、テストが終了するまでこのテスト コマンドを実行します。[Test Engine] 

ツールバーまたはインジケーターの  [Stop] をクリックするか、または TestComplete メイ

ン メニューから [Test] > [Stop] を選択することで、テストの実行をいつでも停止すること

ができます。 

 [Pause] をクリックすることでテスト実行を一時停止することができます。一時停止の間は、必要

な任意の動作を実行することが可能です。たとえば、テスト ログを表示したり、TestComplete の 

[Watch List] や [Locals] パネルあるいは [Evaluate] ダイアログを使用してテストの変数やオブ

ジェクトを確認することが可能です (TestComplete ヘルプの「Debugging Tests」を参照)。 

 TestComplete がインストールされていないマシンでテストを実行するには、TestExecute と呼

ばれるリソース フレンドリーなユーティリティを使用することができます。 

TestComplete のテスト実行、実行に影響するプロジェクト設定、テスト実施に関する詳細は、TestComplete 

ヘルプの「Running Tests」を参照してください。 
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9. テスト結果の分析 

TestComplete は、テスト中に実行されたすべての操作の完全なログを保存します。Project Explorer は、 

テストの結果を Project Suite Logs > SmartStore Log ノードの下に維持しています。これは、プロジェク

トおよびプロジェクト スイートのテスト履歴を表示するための場所です。各ノードは 1 つのテスト実行に対応

します。ノードの左側のアイコンは、対応するテストの実行が成功したかどうかを表します。 

 

テスト実行の終了後、TestComplete は自動的に最終結果のノードを追加します。つまり、テストが実行中のと

きは、結果は表示されません (テストの実行を一時停止した場合は、中間結果を表示することができます)。 

ここまでに実行したテストは 1 つのみなので、Project Explorer には 1 つのログ ノードだけが表示されます。

デフォルトで、TestComplete は、自動的にそのログを開きます。テスト ログを手動で開くには、[Project 

Explorer] パネルで表示したログ ノードをダブルクリックします。 

注意: デフォルトで、TestComplete はログ ファイルにすべてのテスト結果を格納します。テスト実行

ごとにログ ファイル数が増えて、メモリ消費量が増加します。メモリ使用量を減らすために、

手動でログ ファイルを削除したり、保存するログ ファイルの数を制限することができます。 
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この例では、ログは次のようになります。 

 

ログ ウィンドウは、1 度に 1 つのテスト実行の結果を表示します。ウィンドウの左側は、実行されたテストのツ

リー構造で、それぞれのテストのノードを選択してその結果を表示することができます。1 つのテストを実行

した場合、このツリーには 1 つのノードのみ含まれます。このノードのアイコンは、テストが成功したかどうか

を示します。 

テスト ログには、エラー、警告、情報および他の種類のメッセージが含まれています。左のアイコンは、メッ

セージの種類を示します。メッセージ リストの上のチェック ボックスを使用することで、種類によってメッセー

ジを表示/非表示にすることができます。 

それぞれのメッセージでは、アクションが行われた時間が Time 列に表示されます。 

TestComplete は、メッセージとともに追加テキストや画像を出力することがあります。これらを確認するには、

ログ内でメッセージを選択し、メッセージ リストの下にある [Details] や [Picture] ペインを参照します。 

[Picture] パネルでは、選択したテスト コマンドを実行する前に、期待される状態と実際のアプリケーションの

状態を示す画像が表示されます("Expected" (期待される) とはレコーディング中にそのテスト コマンドでキャ

プチャーされた画像を指し、"Actual" (実際) とはテストの実行中にキャプチャーされた画像を指します)。この

画像を比較するには  [View Comparison Results] をクリックして、違いを簡単に見ることができます。 

そのため、テストでエラーが発生した場合、簡単に見つけることができます。詳細については、TestComplete 

ヘルプの「Test Visualizer」を参照してください。 

ログにメッセージを出力したテスト操作を表示するには、ログ内でメッセージをダブルクリックします。すると、

エディターでキーワード テストが開き、該当する操作がハイライトされます。たとえば、ログの "The button 
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was clicked with the left mouse button" メッセージをダブルクリックした場合、この動作が行われたキーワード 

テスト操作がハイライトされます。 

 

テスト ログ パネル、ログへメッセージを出力、その結果の使用に関する詳細情報は、TestComplete ヘルプ

の「About Test Log」を参照してください。 

注意: ここで説明したログは、TestComplete キーワード テストおよびスクリプト特有のログです。 

ほかの種類のテストは異なった構造のログになります。ログに関する詳細情報は、適当な

プロジェクト項目の解説を参照するか、そのログ ページ内をクリックして、F1 を押してくだ

さい。 

エラーの解決 

テストが失敗することがあります。これにはいくつかの可能性があります。たとえば、開発者がアプリケーショ

ンの振る舞いを変更したり、ページと Web 要素の認識属性の変更によりテスト エンジンが必要なオブジェク

トの検出に失敗したり、サードパーティのアプリケーションがテストするアプリケーションの Web ブラウザーに

重なっているためにテスト エンジンがアクションのシミュレートに失敗するなどの可能性があります。 

初めてのユーザーが直面する最も典型的なものは、テスト作成中と再生実行中でアプリケーションの状態

が異なることです。この問題を避けるには、テストを作成したときと同じ初期状態でテスト実行しているか確

認してください。 

例: 

• Web ブラウザーがテストを記録する前に実行されていた場合は、テストを実行する前に実行してい

る必要があります。 

• テストする Web ブラウザーがテストを記録する前に実行されていた場合は、テストを実行する前に

実行している必要があります。 

• アプリケーション内のデータを編集して保存した場合は、変更を元に戻す必要があります。 

テストするアプリケーションが変更され、テストするオブジェクトの検出に使用される識別プロパティが無効に

なると、TestComplete は不足オブジェクトを見つけることができず、テスト ログに "The object does not exist" エ
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ラーを記録します。画面上の実際のオブジェクトをポイントすることで、不足オブジェクトの識別プロパティを

ログから直接更新できます。 

 

エラーの原因を探し、典型的な問題を解決するための詳細情報は、TestComplete ヘルプの「Handling 

Playback Errors」を参照してください。 

10. 複数のブラウザーでのテストの実行 

レコーディングしたブラウザーでテストが正常に実行されることを確認したら、テストを変更して、別のブラウ

ザーで実行することができます (これは、クロスブラウザー テストと呼ばれます)。これにより、Web アプリ

ケーションがさまざまなブラウザーで正しく動作することを確認できます。 

ここで、システムにインストールされているサポートされているすべてのブラウザーでテストが実行されるよう

にテストを修正します。 

1. Keyword Test エディターでテストを開きます。 
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2. Run Browser operation を右クリックして、コンテキスト メニューから [Make Browser Loop] を選択

します。 

 

3. 操作パラメーターのダイアログで、[Iterate Through All Browsers] を選択し、[Finish] をクリック

します。 

 

Run Browser operation が Browser Loop operation に変換されます。 

4. Browser Loop operation の後のすべてのテスト操作を選択し、  をクリックしてこれらの操作をルー

プの内側に移動します。これらの操作はループの各反復で実行されます。 
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変更後のテストは次のようになります。 

 

5. TestComplete のメイン メニューから [File] > [Save] を選択してテストを保存します。 

TestComplete ヘルプの「Preparing Web Browsers」の説明に従って、ほかのブラウザーの準備と設定を行い

ます。 

変更したテストを実行します。 

TestComplete は、ブラウザーの数だけテスト操作を繰り返します。毎回、異なるブラウザーでテスト アクショ

ンが実行されます。 
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テスト ログには、使用したブラウザーに関する情報と、各ブラウザーで実行されたテスト操作の結果が含ま

れます。 

 

TestComplete を使用したクロスブラウザー  テストについての詳細は、 TestComplete ヘルプの

「Cross-Browser Testing – Overview」を参照してください。 
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Android アプリケーションのテスト 

このチュートリアルでは、TestComplete で Android アプリケーションをテストする方法を説明します。これは、

自動テストの一般原則に精通しており、TestComplete IDE についての最低限の知識を持っていることを前

提としています。 

 

 初心者の方は、上記の自動テストの紹介を読むことをお勧めします。 

システム要件 

以下の要件を満たす場合、このチュートリアルの手順に従って Android アプリケーションのテストを作成でき

ます。 

• TestComplete がインストールされた Windows マシンと TestComplete Mobile モジュールのアクティ

ブなライセンス。 

• Appium サーバーが管理する Android デバイスへのアクセス。次のいずれかです。 

o BitBar が提供するモバイル デバイス クラウド。このチュートリアルでは、こちらを使用します。

無料の評価用 BitBar アカウントを作成して、モバイル デバイスにアクセスする方法を紹介

します。 

- または - 

o ローカル マシンまたはローカル ネットワークのリモート マシンで実行しているプライベート 

Appium サーバー。プライベート Appium サーバーの使用法については、このチュートリア

ルではカバーしません。 

注意: このチュートリアルには、Java や Android SDK などの他のソフトウェアは必要ありません。 

チュートリアルについて 

評価用 BitBar アカウントの作成、BitBar デバイス クラウド上の Android モバイル デバイスへの接続、テスト

するアプリケーションの展開、簡単なテストの作成と実行、結果の分析を行います。 
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テストするアプリケーションについて 

この説明では、Orders アプリケーションの Android バージョンを使用します。このアプリケーションは、注文

テーブルを管理します。新しい注文の追加、既存の注文の変更または削除、既存の注文リストの確認を行

うことができます。 

 

アプリケーションを入手するには 

1. 以下の Web サイトから TestComplete Samples インストール パッケージをダウンロードします。 

https://support.smartbear.com/testcomplete/downloads/samples/ 

2. インストールを実行します。 

3. サンプルは、<TestComplete Samples>\Mobile\Android\Orders\ フォルダーにインストールされます。 

1. 無料の BitBar アカウントの申し込み 

TestComplete では、Appium サーバーが管理する Android デバイスに接続して、自動テストを作成して実

行できます。このチュートリアルでは、SmartBear のクラウド モバイル テスト サービス「BitBar」が提供する、

すぐに使えるソリューションを使用します。 

無料の評価用 BitBar アカウントを作成して使用する方法を紹介します。評価用アカウントの申し込みは数

分で完了し、必要なのは有効なメール アドレスのみです。 

https://support.smartbear.com/testcomplete/downloads/samples/
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チュートリアルを開始する前に申し込むことも、スキップして後で実際にテストのレコーディングを開始する

際に申し込むこともできます。 

1. 評価用 BitBar アカウントの申し込み 

1. 以下のリンクをクリックして、BitBar Web サイトで無料の評価用アカウントの申し込み手続きを行って

ください。 

bitbar.com/signup 

2. Web フォームの指示に従ってください。 

2. BitBar API Key の入手 

TestComplete のテストから BitBar リソースにアクセスするには、BitBar API Key を使用します。キーを取得

するには 

1. 作成した BitBar アカウントで BitBar にログインします。 

2. ページの右上にある  > [My Account] をクリックします。 

3. [My Integrations] セクションで [API] をクリックします。 

4. 結果ページで  をクリックして、API Key をクリップボードにコピーします。 

 

2. テストのレコーディング開始  

1. TestComplete でプロジェクトあるいはプロジェクト スイートを開いている場合は、閉じてください。 

これをするには、[File] > [Close] を TestComplete のメインメニューから選択します。 

https://bitbar.com/signup/
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2. TestComplete スタート ページに切り替えます。このページが隠れている場合、TestComplete の 

[Help] メニューから [Start Page] を選択します。 

 

3. スタートページで、  [Record Test] をクリックします。TestComplete は、[Record Test] ウィザー

ドを表示します。 

 

4. ウィザードの最初のページで、プロジェクトの名前、場所、テスト タイプを指定します。 

[Project name] テキスト ボックスに Orders と入力します。 

[Location] テキスト ボックスはデフォルトの値のままにします。 
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テスト タイプを選択します。キーワードテストまたは JavaScript、Python スクリプト テストのいずれかを

作成することができます。 

• キーワードテストは、マウスのクリック、テキストの入力など、ユーザーの操作を定義する一連の

キーワードです。視覚的にキーワード テストを作成します。スクリプトの知識は必要ではありま

せん。 

• JavaScript と Python テストは、ユーザー アクションをシミュレートする命令を含むスクリプト関数

です。 

このチュートリアルでは、キーワード テストの作成方法を示します。[Keyword] をクリックします。 

5. [Next] をクリックします。 

ウィザードを使って、テストするアプリケーションをプロジェクトに追加するため、ウィザードで作業を

続行します。 

3. テストするアプリケーションの定義 

モバイル デバイスで実行するアプリケーションのテストを作成するには、そのデバイスへアプリケーションを

展開する必要があります。BitBar モバイル デバイス クラウド プロバイダーを使用する場合は、アプリケー

ション ファイル (Orders.apk) をアカウントのファイル ライブラリにアップロードします。TestComplete からファ

イルをアップロードする最も簡単な方法は、テストのレコーディングの開始時などに、TestComplete プロジェ

クトにファイルを追加することです。 

1. ウィザードでは、テストするアプリケーションを選択できる 2 番目のページが表示されます。 

 

2. テストする Orders アプリケーションは、.apk ファイルとして出荷される Android アプリケーションなの

で、Mobile アプリケーションのカテゴリに該当します。 

https://bitbar.com/
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[Mobile] をクリックします。 

3. [Mobile application file] ダイアログで、[...] ボタンをクリックします。表示される [Select Tested 

Application] ダイアログで、Orders.apk ファイルの場所を見つけます。 

[Reupload the tested application to BitBar when connecting to a device, if needed] 

チェックボックスはデフォルトのままオンにします。 

4. すでに BitBar アカウントを持っている場合は、アカウントに割り当てられた API Key を [BitBar API 

Key] テキストボックスに入力します。 

API Key の取得方法は、前述の手順を参照してください。 

このチュートリアルのステップ 1 をスキップした場合は、ウィザードの [Sign up] リンクをクリックすると

無料の評価用アカウントを申し込むことができます。 

5. [Record] をクリックし、プロジェクトの作成を完了し、レコーディングを開始します。 

4. デバイスへ接続してテスト セッションを開く 

レコーディングを開始する前に、テストをレコーディングするデバイスを選択して、Orders アプリケーションの

テスト セッションを開きます。 

1. [Select BitBar Device] ダイアログが表示されます。BitBar が提供するすべてのモバイル デバイ

スがリストされます。 

 

2. 任意の利用可能な Android デバイスを選択します。デバイスが利用可能かどうかは [Status] カラ

ムで確認できます。 
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評価ユーザー向けにいくつかのデバイスが用意されています。このチュートリアルでは、Google 

Pixel を使用します。 

適切なデバイスをすばやく見つけるには、プラットフォーム、バージョン、名前でデバイス  リストを

フィルタリングできます。 

3. Orders アプリケーションのテスト セッションを開くには、アプリケーションがターゲット デバイスにアッ

プロードされている必要があります。前のステップで有効な  .apk ファイルを指定した場合、

TestComplete はファイルを自動的にアップロードします。 

4. [OK] をクリックして続行します。 

TestComplete は選択されたデバイスへ接続して、デバイスに Orders アプリケーションをインストールし、アプ

リケーションのテスト セッションを開きます。TestComplete の [Mobile Screen] ウィンドウに接続デバイスの

画面が表示されます。テストするアプリケーションのユーザー アクションをレコーディングするには、そのウィ

ンドウでアプリケーションを操作します。 

5. テストのレコーディング 

注意: レコーディング中に TestComplete ヘルプに切り替えないでください。レコーディング エンジ

ンはすべてのユーザー アクションをトレースし、レコーディングします。つまり、レコーディン

グしたテストに、この "切り替え" をシミュレートするコマンドが含まれてしまいます。  

操作手順は、レコーディングを開始する前に印刷しておくことができます。あるいは、2 つの

モニターがある場合、TestComplete ヘルプをもう一方のモニターへ移動しておくことができ

ます。 
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1. [Mobile Screen] にアプリケーションの初期ウィンドウが表示されるまで待機します。 

 

アプリケーションが開始されない場合は、手動で起動します。 
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2. [Mobile Screen] ウィンドウで Samuel Clemens の注文をクリックして、[Edit] ボタンをクリックします。 

 

Orders アプリケーションが編集モードに切り替わります。 
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3. 注文の詳細情報で顧客名を変更してみましょう。 

Samuel Clemens を消去して、Mark Twain と入力し、Enter キーを押します。デスクトップのキーボー

ドを使用して、[Mobile Screen] ウィンドウでテキストを入力します。 
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4. [Edit Order] ページをスクロール ダウンして、[OK] をクリックします。これにより、注文の変更が保存

され、注文リストに戻ります。 

 

5. テストに比較コマンドを挿入します。この比較コマンドは、アプリケーションの顧客リストに変更した名

前 (Mark Twain) が含まれることを検証します。 

比較コマンドをチェックポイントと呼びます。TestComplete には、異なる種類のデータを検証するさま

ざまな種類のチェックポイントが用意されています。最もよく使用されるチェックポイントの 1 つは、 

プロパティ チェックポイントです。アプリケーション コントロールのデータのチェックに使用されます。

このチュートリアルでは、このチェックポイントを使用して [Customer Name] テキスト ボックスの値を

検証します。 

a. [Recording] ツールバーの  [Add Check] をクリックします。 

 

[Checkpoint] ウィザードが呼び出されます。このウィザードを利用して、チェックポイントを作成

します。 
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b. ウィザードの最初のページで、[Text or property] をクリックします。 
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c. ターゲット アイコン ( ) をマウスの左ボタンでクリックして押したままにします。 

ウィザードが最小化されるまで待ってから、そのアイコンを Orders アプリケーションの注文リスト

にドラッグします。ドラッグしている間、マウス カーソル下のコントロールとウィンドウが赤いフレー

ムでハイライトされます。 

[ターゲット アイコン] を Mark Twain の注文の上に移動し、その項目全体が赤いフレームでハイ

ライトされたら、マウスのボタンを離します。 
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d. マウスのボタンを離すと、ウィザードに戻り、選択したオブジェクトの名前が [Object] ボックスに

表示され、その下にオブジェクトの画像が表示されます。 

 

[Next] をクリックします。 
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e. ウィザードの次のページには、チェックのための提案されたプロパティのリストが表示されます。 

 

このリストには、テストするアプリケーションによって定義されたプロパティと TestComplete によっ

て提供されるプロパティが含まれます。利用可能なすべてのプロパティを表示するには、[More 

Properties] をクリックします。 
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f. テーブルで、Text プロパティが選択されていることを確認します。[Condition] カラムで 

[Equals (case-sensitive)] 条件が選択されていることを確認します。 

 

g. [Finish] をクリックしてチェックポイント作成を完了します。レコーディングしたテストにチェックポ

イント コマンドが追加されます。 

6. [Recording] ツールバーの  [Stop] を押して、レコーディングを停止します。レコーディングしたテ

スト コマンドが処理され、キーワード テストに保存されます。 
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6. レコーディングしたテストの分析 

レコーディング終了後、TestComplete はレコーディングしたキーワードを Keyword Test エディターで開き

ます。 

 

レコーディングしたテストは上記の画像に示すテストのようになります。実行環境によってはこれとは異なる

ことがあります。たとえば、不要なタッチ操作が含まれていることがあります。 

このテストには、レコーディング中に Orders アプリケーション上で実行した動作に対応するコマンドが含まれ

ています。このテスト コマンドを operation と呼びます。 
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このテストの最初の operation は、Run Remote Device です。この operation は、BitBar モバイル デバイス 

クラウドのモバイル デバイスに接続して、Orders アプリケーションを指定したデバイスに展開し、アプリケー

ションのテスト セッションを開きます。以降のテスト操作はすべてこのデバイスに関するものです。 

 

その後、アプリケーションでのユーザー  アクションをシミュレートする operation が続きます。これらの 

operation は、[Edit] ボタンをクリックし、注文リストから項目を選択し、テキスト フィールドの値を変更し、変更

を保存して [Done] ボタンをクリックします。 

 

最後に、テスト レコーディング中に追加した比較動作です。 
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レコーディングしたテストのアプリケーションとオブジェクトの名前に注意する必要があります。 

 

デフォルトでは、テストをレコーディングしている間、TestComplete は自動的にすべての項目を Name 

Mapping リポジトリに追加します。項目ごとに、TestComplete はテストの実行中にアプリケーション内のオ

ブジェクトを見つけるために使用する検索式と、alias を格納します。alias はテスト内のオブジェクトを見つ

けるために使用する短い名前です。 

Project Explorer の  Name Mapping 項目をダブルクリックして、Name Mapping リポジトリを開き、

TestComplete がテストのレコーディング中にオブジェクト用に作成した認識パラメーターと alias を表示でき

ます。 

 

Name Mapping と alias の使用は、テストをより分かりやすく、安定したものにします。 
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7. テストの実行 

レコーディングしたテストを実行するには、テスト エディターのツールバーにある  [Run] をクリックします。 

 

TestComplete は、BitBar デバイス クラウドの指定したデバイスに接続して、デバイスで Orders アプリケー

ションを起動し、レコーディングしたアクション (Samuel Clemens の注文を開き、顧客名を Mark Twain に変

更する) を再生実行します。 

注意: テスト実行中は、マウスを動かしたり、キーを押したりしないでください。TestComplete でシ

ミュレートされる動作を妨げたり、テスト実行が正しく行われない可能性があります。 

テスト実行の終了後、TestComplete はテスト結果を表示します。次の手順では、これを分析します。 

テスト実行に関するいくつかの注意: 

 テストの実行中、TestComplete は、画面の右上にインジケーターを表示します。  

 

このインジケーターは、シミュレートしたテスト動作に関する通知をするためのメッセージを表示し

ます。 

 TestComplete は、テストが終了するまでこのテスト コマンドを実行します。[Test Engine] 

ツールバーまたはインジケーターの  [Stop] をクリックするか、または TestComplete メイ

ン メニューから [Test] > [Stop] を選択することで、テストの実行をいつでも停止すること

ができます。 

 [Pause] をクリックすることでテスト実行を一時停止することができます。一時停止の間は、必要

な任意の動作を実行することが可能です。たとえば、テスト ログを表示したり、TestComplete の 

[Watch List] や [Locals] パネルあるいは [Evaluate] ダイアログを使用してテストの変数やオブジェ

クトを確認することが可能です (TestComplete ヘルプの「Debugging Tests」を参照)。 

TestComplete のテスト実行、実行に影響するプロジェクト設定、テスト実施に関する詳細は、TestComplete 

ヘルプの「Running Tests」を参照してください。 
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8. テスト結果の分析 

テスト終了後、すべてのテスト操作の結果を含むテスト ログが表示されます。この例では、ログは次のように

なります。 

 

ログには、アクション、イベント、チェックポイントなどに関するさまざまなメッセージが含まれています。 

メッセージ リストの上のツールバーを使用してメッセージをフィルタリングできます。ログ メッセージをダブル

クリックすると、そのメッセージを出力したテスト操作が表示されます。これは、エラーの原因となった操作を

把握するのに便利です。 

[Picture] パネルには、選択したテスト コマンドが実行されると、アプリケーションの状態を示す画像が含ま

れます。これらの画像は、テスト実行中のアプリケーションの動作を理解し、エラーを迅速に見つけるのに

役立ちます。 

[Details] パネルには、実行された操作の詳細が表示されます。たとえば、プロパティ チェックポイントの 

[Details] には、チェック タイプ (equals、contains、matches a regular expression など) およびその他の詳細が

含まれます。 
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すべてのログが Project Explorer の [Project Suite Logs] > [ProjectName Logs] にあるため、以前の

ログを見ることもできます。 

 

エラーの解決 

テストが失敗することがあります。これにはいくつかの可能性があります。たとえば、開発者がアプリケーショ

ンの動作を変更したり、アプリケーション コントロールの認識属性が変わりテスト エンジンが必要なオブジェ

クトを見つけられなくなったりする可能性があります。 

初めてのユーザーが直面する最も典型的なものは、テスト作成中と再生実行中でアプリケーションの状態

が異なることです。この問題を避けるには、テストを作成したときと同じ初期状態でテスト実行しているか確

認してください。以下に例を示します。 

• テストするアプリケーションがテストを記録する前に実行されていた場合は、テストを実行する前に

実行している必要があります。 

• テストアクションがアプリケーションの特定の画面で実行された場合は、テストを実行するときにもそ

の画面を開く必要があります。 

• アプリケーション内のデータを編集して保存した場合は、変更を元に戻す必要があります。 

特定のアプリケーションの応答を待つ必要があるため、テスト エンジンがアプリケーション オブジェクトを検

出できないことがあります。この問題を解決するには、Delay コマンドを挿入し、テキストの実行を一時停止

する時間を指定します。 

• キーワード テストでは、指定した Delay Time (遅延時間) パラメーターで Delay オペレーションを使

用します。 

• スクリプトでは、ループ本体に aqUtils.Delay メソッドを使用します。

C:\work\reference\program-objects\aqutils\delay.htm 

file:///C:/work/reference/program-objects/aqutils/delay.htm
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エラーの原因を探し、典型的な問題を解決するための情報は、TestComplete ヘルプの「Handling Playback 

Errors」を参照してください。 
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iOS アプリケーションのテスト 

このチュートリアルでは、TestComplete で iOS アプリケーションをテストする方法を説明します。これは、 

自動テストの一般原則に精通しており、TestComplete IDE についての最低限の知識を持っていることを前

提としています。  

 初心者の方は、上記の自動テストの紹介を読むことをお勧めします。 

システム要件 

以下の要件を満たす場合、このチュートリアルの手順に従って iOS アプリケーションのテストを作成でき

ます。 

• TestComplete がインストールされた Windows マシンと TestComplete Mobile モジュールのアクティ

ブなライセンス。 

• Appium サーバーが管理する iOS デバイスへのアクセス。次のいずれかです。 

o BitBar が提供するモバイル デバイス クラウド。このチュートリアルでは、こちらを使用します。

無料の評価用 BitBar アカウントを作成して、モバイル デバイスにアクセスする方法を紹介

します。 

- または - 

o ローカル マシンまたはローカル ネットワークのリモート マシンで実行しているプライベート 

Appium サーバー。プライベート Appium サーバーの使用法については、このチュートリア

ルではカバーしません。 

• サンプル Orders アプリケーションをコンパイルするための、Xcode、iOS SDK、および iOS 開発ライ

センスを備えた Mac マシン。 

注意: このチュートリアルには、iTunes などの他のツールやユーティリティは必要ありません。 

チュートリアルについて 

評価用 BitBar アカウントの作成、BitBar デバイス クラウド上の iOS モバイル デバイスへの接続、テストする

アプリケーションの展開、簡単なテストの作成と実行、結果の分析を行います。 
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テストするアプリケーションについて 

この説明では、Orders アプリケーションの iOS バージョンを使用します。このアプリケーションは、注文テー

ブルを管理します。新しい注文の追加、既存の注文の変更または削除、既存の注文リストの確認を行うこと

ができます。 

 

アプリケーションを入手するには 

1. 以下の Web サイトから TestComplete Samples インストール パッケージをダウンロードします。 

https://support.smartbear.com/testcomplete/downloads/samples/ 

2. インストールを実行します。 

3. サンプルは、<TestComplete Samples>\Mobile\iOS\Orders\ フォルダーにインストールされます。 

アプリケーションは Mac 上でコンパイルする必要があります。 

https://support.smartbear.com/testcomplete/downloads/samples/
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1. 無料の BitBar アカウントの申し込み 

TestComplete では、Appium サーバーが管理する iOS デバイスに接続して、自動テストを作成して実行で

きます。このチュートリアルでは、SmartBear のクラウド モバイル テスト サービス「BitBar」が提供する、すぐ

に使えるソリューションを使用します。 

無料の評価用 BitBar アカウントを作成して使用する方法を紹介します。評価用アカウントの申し込みは数

分で完了し、必要なのは有効なメール アドレスのみです。 

チュートリアルを開始する前に申し込むことも、スキップして後で実際にテストのレコーディングを開始する

際に申し込むこともできます。 

1. 評価用 BitBar アカウントの申し込み 

1. 以下のリンクをクリックして、BitBar Web サイトで無料の評価用アカウントの申し込み手続きを行って

ください。 

bitbar.com/signup 

2. Web フォームの指示に従ってください。 

2. BitBar API Key の入手 

TestComplete のテストから BitBar リソースにアクセスするには、BitBar API Key を使用します。キーを取得

するには 

1. 作成した BitBar アカウントで BitBar にログインします。 

2. ページの右上にある  > [My Account] をクリックします。 

3. [My Integrations] セクションで [API] をクリックします。 

4. 結果ページで  をクリックして、API Key をクリップボードにコピーします。 

 

https://bitbar.com/signup/
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2. テストのレコーディング開始  

1. TestComplete でプロジェクトあるいはプロジェクト スイートを開いている場合は、閉じてください。 

これをするには、[File] > [Close] を TestComplete のメインメニューから選択します。 

2. TestComplete スタート ページに切り替えます。このページが隠れている場合、TestComplete の 

[Help] メニューから [Start Page] を選択します。 

 

3. スタートページで、  [Record Test] をクリックします。TestComplete は、[Record Test] ウィザー

ドを表示します。 

 

4. ウィザードの最初のページで、プロジェクトの名前、場所、テスト タイプを指定します。 
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[Project name] テキスト ボックスに Orders と入力します。 

[Location] テキスト ボックスはデフォルトの値のままにします。 

テスト タイプを選択します。キーワードテストまたは JavaScript、Python スクリプト テストのいずれかを

作成することができます。 

• キーワードテストは、マウスのクリック、テキストの入力など、ユーザーの操作を定義する一連の

キーワードです。視覚的にキーワード テストを作成します。スクリプトの知識は必要ではありま

せん。 

• JavaScript と Python テストは、ユーザー アクションをシミュレートする命令を含むスクリプト関数

です。 

このチュートリアルでは、キーワード テストの作成方法を示します。[Keyword] をクリックします。 

5. [Next] をクリックします。 

ウィザードを使って、テストするアプリケーションをプロジェクトに追加するため、ウィザードで作業を

続行します。 

3. テストするアプリケーションの定義 

モバイル デバイスで実行するアプリケーションのテストを作成するには、そのデバイスへアプリケーションを

展開する必要があります。BitBar モバイル デバイス クラウド プロバイダーを使用する場合は、アプリケー

ション ファイル (Orders.ipa) をアカウントのファイル ライブラリにアップロードします。TestComplete からファイ

ルをアップロードする最も簡単な方法は、テストのレコーディングの開始時などに、TestComplete プロジェク

トにファイルを追加することです。 

https://bitbar.com/
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1. ウィザードでは、テストするアプリケーションを選択できる 2 番目のページが表示されます。 

 

2. Orders アプリケーションは、.ipa ファイルとして出荷される iOS アプリケーションなので、Mobile アプ

リケーションのカテゴリに該当します。 

[Mobile] をクリックします。 

3. [Mobile application file] ダイアログで、[...] ボタンをクリックします。表示される [Select Tested 

Application] ダイアログで、Orders.ipa ファイルの場所を見つけます。 

[Reupload the tested application to BitBar when connecting to a device, if needed] 

チェックボックスはデフォルトのままオンにします。 

4. すでに BitBar アカウントを持っている場合は、アカウントに割り当てられた API Key を [BitBar API 

Key] テキストボックスに入力します。 

API Key の取得方法は、前述の手順を参照してください。 

このチュートリアルのステップ 1 をスキップした場合は、ウィザードの [Sign up] リンクをクリックすると

無料の評価用アカウントを申し込むことができます。 

5. [Record] をクリックし、プロジェクトの作成を完了し、レコーディングを開始します。 

4. デバイスへ接続してテスト セッションを開く 

レコーディングを開始する前に、テストをレコーディングするデバイスを選択して、Orders アプリケーションの

テスト セッションを開きます。 
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1. [Select BitBar Device] ダイアログが表示されます。BitBar が提供するすべてのモバイル デバイ

スがリストされます。 

 

2. 任意の利用可能な iOS デバイスを選択します。デバイスが利用可能かどうかは [Status] カラムで

確認できます。 

評価ユーザー向けにいくつかのデバイスが用意されています。このチュートリアルでは、iPhone 7 を

使用します。 

適切なデバイスをすばやく見つけるには、プラットフォーム、バージョン、名前でデバイス  リストを

フィルタリングできます。 

3. Orders アプリケーションのテスト セッションを開くには、アプリケーションがターゲット デバイスにアッ

プロードされている必要があります。前のステップで有効な  .ipa ファイルを指定した場合、

TestComplete はファイルを自動的にアップロードします。 

4. レコーディングの開始時に選択したデバイスでテストするアプリケーションを自動的に開始するには、

アプリケーションのバンドル ID を指定します。これは、指定した .ipa ファイルのコンパイルに使用さ

れたバンドル ID です。 
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[Custom Parameters] タブに切り替えて、パラメーター リストに bundleId を追加します。 

 

このステップをスキップすると、手動でアプリケーションを起動する必要があります。 

5. デフォルトでは、BitBar クラウドで実行するモバイル デバイスは、すべての通知、メッセージ、およ

びアラートを自動的に閉じるように設定されています。このチュートリアルでは、Orders アプリケー

ションが表示するアラートに対するユーザー アクションをレコーディングするため、デバイスがア

ラートを自動的に処理しないように設定します。 
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[Custom Parameters] タブで、パラメーター リストに autoAcceptAlerts または autoDismissAlerts を

追加して false に設定します。 

 

6. たとえば、次のようにカスタム パラメーターを設定します。テストするアプリケーションのコンパイルに

使用した適切なバンドル ID を指定してください。 

{ 

  "bundleId": "<Your_bundle_id>", 

  "autoAcceptAlerts": false 

}  

7. [OK] をクリックして続行します。 

TestComplete は選択されたデバイスへ接続して、デバイスに Orders アプリケーションをインストールし、アプ

リケーションのテスト セッションを開きます。TestComplete の [Mobile Screen] ウィンドウに接続デバイスの画

面が表示されます。テストするアプリケーションのユーザー アクションをレコーディングするには、そのウィン

ドウでアプリケーションを操作します。 
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5. テストのレコーディング 

 テストのレコーディング中に TestComplete ヘルプに切り替えないでください。レコーディング 

エンジンはすべてのユーザー アクションをトレースし、レコーディングするため、レコーディン

グしたテストにこの動作が含まれてしまいます。  

操作手順は、レコーディングを開始する前に印刷しておくことができます。あるいは、モニター

が 2 つある場合は、TestComplete ヘルプをもう一方のモニターへ移動しておくことができます。 

1. TestComplete は、テストのレコーディングを開始し、レコーディング モードに切り替わり、画面上に 

[Recording] ツールバーが表示されます。 

 

2. [Mobile Screen] にアプリケーションの初期ウィンドウが表示されるまで待機します。 

注意: バンドル ID の指定をスキップした場合、アプリケーションは自動的に開始しません。手動で起

動してください。 
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3. [Mobile Screen] ウィンドウで [Edit] ボタンをクリックします。 

 

Orders アプリケーションが編集モードに切り替わります。 

4. リストの 2 つめにある Samuel Clemens の注文をクリックします。[Edit Order] パネルが表示されます。 
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5. 注文の詳細情報で顧客名を変更してみましょう。 

Samuel Clemens を消去して、Mark Twain と入力し、Enter キーを押します。デスクトップのキーボー

ドを使用して、[Mobile Screen] ウィンドウでテキストを入力します。 

6. [Edit Order] パネルの [Save] ボタンをクリックし、変更を確定します。 

7. iPhone デバイス (一度に 1 つのパネルしか表示されない) でレコーディングする場合は、ナビゲー

ション バーにある Orders ボタンをタッチすると、[Orders List] パネルが表示されます。 

iPad デバイスは両方のパネルを同時に表示できるため、このアクションは必要ありません。 

8. [Done] ボタンをクリックして編集モードを終了します。 

 

注文リストが通常モードに戻ります。 

9. テストに比較コマンドを挿入します。この比較コマンドは、アプリケーションの顧客リストに変更した

名前 (Mark Twain) が表示されることを検証します。 

比較コマンドをチェックポイントと呼びます。TestComplete には、異なる種類のデータを検証するさ

まざまな種類のチェックポイントが用意されています。最もよく使用されるチェックポイントの 1 つは、

プロパティ チェックポイントです。アプリケーション コントロールのデータのチェックに使用されます。

このチュートリアルでは、このプロパティ チェックポイントを使用します。 
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• [Recording] ツールバーの  [Add Check] をクリックします。 

 

[Checkpoint] ウィザードが呼び出されます。このウィザードを利用して、チェックポイントを作成

します。 

• ウィザードの最初のページで、[Text or property] をクリックします。 

 

• ターゲット アイコン ( ) をマウスの左ボタンでクリックして押したままにします。 

ウィザードが最小化されるまで待ってから、そのアイコンを Orders アプリケーションの注文リスト

にドラッグします。ドラッグしている間、マウス カーソル下のコントロールとウィンドウが赤いフレー

ムでハイライトされます。 
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[ターゲット アイコン] を Mark Twain の注文の上に移動し、その項目全体が赤いフレームでハイ

ライトされたら、マウスのボタンを離します。 
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• マウスのボタンを離すと、ウィザードに戻り、選択したオブジェクトの名前が [Object] ボックスに

表示され、その下にオブジェクトの画像が表示されます。 

 

[Next] をクリックします。 

• ウィザードの次のページには、チェックのための提案されたプロパティのリストが表示されます。 

 

このリストには、テストするアプリケーションによって定義されたプロパティと TestComplete によっ

て提供されるプロパティが含まれます。利用可能なすべてのプロパティを表示するには、[More 

Properties] をクリックします。 
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• [Text] プロパティが選択され、[Condition] カラムで [Equals (case-sensitive)] 条件が選択

されていることを確認します。 

 

• [Finish] をクリックしてチェックポイント作成を完了します。レコーディングしたテストにチェックポ

イント コマンドが追加されます。 

10. [Recording] ツールバーの  [Stop] を押して、レコーディングを停止します。レコーディングしたテ

スト コマンドが処理され、キーワード テストに保存されます。 
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6. レコーディングしたテストの分析 

レコーディング終了後、TestComplete はレコーディングしたキーワードを Keyword Test エディターで開き

ます。 

 

レコーディングしたテストは上記の画像に示すテストのようになります。実行環境によってはこれとは異なる

ことがあります。たとえば、不要なタッチ操作が含まれていることがあります。 

このテストには、レコーディング中に Orders アプリケーション上で実行した動作に対応するコマンドが含まれ

ています。このテスト コマンドを operation と呼びます。 
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このテストの最初の operation は、Run Remote Device です。この operation は、BitBar モバイル デバイス 

クラウドのモバイル デバイスに接続して、Orders アプリケーションを指定したデバイスに展開し、アプリケー

ションのテスト セッションを開きます。以降のテスト操作はすべてこのデバイスに関するものです。 

 

その後、アプリケーションでのユーザー  アクションをシミュレートする operation が続きます。これらの 

operation は、[Edit] ボタンをクリックし、注文リストから項目を選択し、テキスト フィールドの値を変更し、変更

を保存して [Done] ボタンをクリックします。 
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最後に、テスト レコーディング中に追加した比較動作です。 

 

レコーディングしたテストのアプリケーションとオブジェクトの名前に注意する必要があります。 

 

デフォルトでは、テストをレコーディングしている間、TestComplete は自動的にすべての項目を Name 

Mapping リポジトリに追加します。項目ごとに、TestComplete はテストの実行中にアプリケーション内のオ

ブジェクトを見つけるために使用する検索式と、alias を格納します。alias はテスト内のオブジェクトを見つ

けるために使用する短い名前です。 
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Project Explorer の  Name Mapping 項目をダブルクリックして、Name Mapping リポジトリを開き、

TestComplete がテストのレコーディング中にオブジェクト用に作成した認識パラメーターと alias を表示でき

ます。 

 

Name Mapping と alias の使用は、テストをより分かりやすく、安定したものにします。 

7. レコーディングしたテストの実行 

テストを実行してその動作を検証してみましょう。 

テストの実行 

テストを実行するには、テスト エディターのツールバーにある  [Run Test] をクリックします。 

 

TestComplete は、BitBar デバイス クラウドの指定したデバイスに接続して、デバイスで Orders アプリケー

ションを起動し、レコーディングしたアクション (Samuel Clemens の注文を開き、顧客名を Mark Twain に変

更する) を再生実行します。 
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テスト結果 

テストの終了後、テスト結果が表示され、テストが成功したか、失敗したかを確認できます。テスト結果につ

いては、このチュートリアルの次のステップで詳しく説明します。 

テスト実行に関する注意 

 重要: テスト実行中は、テスト動作の妨げとならないように、デバイスの画面に触れないで

ください。 

 テスト実行中、画面の右上隅にある TestComplete インジケーターは、実行されたテスト操

作に関する情報を表示します。  

 

このインジケーターは、シミュレートしたテスト動作に関する通知をするためのメッセージを表示し

ます。 

 [Test Engine] ツールバーまたはインジケーターの   [Stop] をクリックするか、または 

TestComplete メイン メニューから [Test] > [Stop] を選択することで、テストの実行をいつ

でも停止することができます。 

インジケーターの  [Pause] をクリックすることでテスト実行を一時停止することができます。一時停

止の間は、必要な任意の動作を実行することが可能です。たとえば、テスト  ログを表示したり、

TestComplete の [Watch List] や [Locals] パネルあるいは [Evaluate] ダイアログを使用してテストの

変数やオブジェクトを確認することが可能です (TestComplete ヘルプの「Debugging Tests」を参照)。 

詳細に関する情報は、TestComplete ヘルプの 「Running Tests」 を参照してください。 
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8. テスト結果の分析 

テスト終了後、すべてのテスト操作の結果を含むテスト ログが表示されます。この例では、ログは次のように

なります。 

 

ログには、アクション、イベント、チェックポイントなどに関するさまざまなメッセージが含まれています。メッ

セージ リストの上のツールバーを使用してメッセージをフィルタリングできます。ログ メッセージをダブルク

リックすると、そのメッセージを出力したテスト操作が表示されます。これは、エラーの原因となった操作を把

握するのに便利です。 

[Picture] パネルには、選択したテスト コマンドが実行されると、アプリケーションの状態を示す画像が含ま

れます。これらの画像は、テスト実行中のアプリケーションの動作を理解し、エラーを迅速に見つけるのに

役立ちます。 

[Details] パネルには、実行された操作の詳細が表示されます。たとえば、プロパティ チェックポイントの 

[Details] には、チェック タイプ (equals、contains、matches a regular expression など) およびその他の詳細が

含まれます。 

すべてのログが Project Explorer の [Project Suite Logs] > [ProjectName Logs] にあるため、以前の

ログを見ることもできます。 
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エラーの解決 

テストが失敗することがあります。これにはいくつかの可能性があります。たとえば、開発者がアプリケーショ

ンの動作を変更したり、アプリケーション コントロールの認識属性が変わりテスト エンジンが必要なオブジェ

クトを見つけられなくなったりする可能性があります。 

初めてのユーザーが直面する最も典型的なものは、テスト作成中と再生実行中でアプリケーションの状態

が異なることです。この問題を避けるには、テストを作成したときと同じ初期状態でテスト実行しているか確

認してください。 

例: 

• テストするアプリケーションがテストを記録する前に実行されていた場合は、テストを実行する前に

実行している必要があります。 

• テストアクションがアプリケーションの特定の画面で実行された場合は、テストを実行するときにもそ

の画面を開く必要があります。 

• アプリケーション内のデータを編集して保存した場合は、変更を元に戻す必要があります。 

特定のアプリケーションの応答を待つ必要があるため、テスト エンジンがアプリケーション オブジェクトを検

出できないことがあります。この問題を解決するには、Delay コマンドを挿入し、テキストの実行を一時停止

する時間を指定します。 

• キーワード テストでは、指定した Delay Time (遅延時間) パラメーターで Delay オペレーションを使

用します。 

• スクリプトでは、ループ本体に aqUtils.Delay メソッドを使用します。

C:\work\reference\program-objects\aqutils\delay.htm 

エラーの原因を探し、典型的な問題を解決するための情報は、TestComplete ヘルプの「Handling Playback 

Errors」を参照してください。 

file:///C:/work/reference/program-objects/aqutils/delay.htm
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次のステップ 

スタート ガイド チュートリアルはこれで終了です。このスタート ガイドが TestComplete の理解に役立つことを

願っています。他のアプリケーション タイプのテストを作成する方法を習得したり、高度な機能を習得し独自

のテストを作成してみてください。TestComplete とその機能についての詳細情報は、TestComplete ヘルプ

を参照してください。いくつかのヘルプ トピックを次に示します。 

共通トピック 

➢ TestComplete によるレコーディング (Recording in TestComplete) 

このセクションには、TestComplete によるテストのレコーディングに関する情報があります。 

➢ チェックポイント (Checkpoints) 

このセクションは、テスト エンジンによって提供されるさまざまなチェックポイントの種類と、テストのレ

コーディング中およびデザイン時にチェックポイントを作成する方法を説明します。 

➢ テストの実行 (Running Tests) 

このセクションには、テスト実行の方法、バッチ実行 (テストのグループを実行) の設定方法、テスト

実行の予定の立て方などの情報があります。 

➢ テスト ログ (Test Log) 

TestComplete によるテスト結果の記録方法とテスト ログ パネルについて説明します。このセクション

では、メッセージ、画像、ファイルをログに投稿する方法についても説明します。 

➢ 再生実行エラーの対応 (Handling Playback Errors) 

テスト実行中に発生したエラーの対応方法を説明します。 

➢ TestComplete の使用 (Working With TestComplete) 

TestComplete プロジェクトをチーム メンバーと共有する方法、TestComplete テストをビルド、開発、

品質保証プロセスに統合する方法がわかります。 

デスクトップ アプリケーションに関するトピック 

➢ オブジェクトの命名方法 (Naming Objects) 

このセクションには、TestComplete によるプロセス、ウィンドウ、コントロールの名前の付け方に関す

る情報があります。 

➢ ユーザー アクションのシミュレーション (Simulating User Actions) 

このセクションは、TestComplete を用いたマウス クリック、キーストローク、メニュー項目の選択のシ

ミュレートについて説明します。 
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➢ アプリケーションのオブジェクトとコントロールの使用  (Working With Applications’  Object and 

Controls) 

このセクションは、テスト オブジェクトに対する特定のアクションの実行方法と、そこからデータを取り

込む方法を説明します。 

➢ 詳細なタスク (Advanced Tasks) 

テストの拡張に役立つさまざまな TestComplete 機能に関する情報が得られます (イベントの処理方

法、ActiveX オブジェクト、ファイル、データベースの使用方法など)。 

Web アプリケーションに関するトピック 

➢ デフォルト の Web テスト (Default Web Testing)  

TestComplete によるプロパティを利用して Web オブジェクトを識別する Web テストの作成方法につ

いて説明します。 

➢ TestComplete のクロスブラウザー テスト (Cross-Browser Testing in TestComplete)  

CSS セレクターの XPath 式を利用して Web オブジェクトを識別する Web テストの作成方法と、デバ

イス クラウドでのテストの実行方法を説明します。 

➢ クロスプラットフォーム Web テストの並列実行 (Running Cross-Platform Web Tests in Parallel) 

デバイス クラウドでクロス プラットフォーム Web テストを並列に実行する方法を説明します。 

➢ エキュレーターを使用したモバイル Web アプリケーションのテスト (Testing Mobile Web Applications 

Using Emulator – Tutorial) 

サンプルのクロスブラウザー モバイル Web テストを作成するためのステップ バイ ステップのチュー

トリアル 

モバイル アプリケーションに関するトピック 

➢ モバイル テストについて (About Mobile Tests) 

TestComplete を使用したモバイル テストの作成方法を説明します。 

➢ モバイル デバイスへ接続してテスト セッションを開く (Connecting to Mobile Devices and Opening 

Testing Sessions) 

TestComplete からモバイル デバイスへの接続方法を示します。 

➢ モバイル テストの作成と実行 (Creating and Running Mobile Tests) 

モバイル デバイスで自動テストを作成して実行するステップ バイ ステップの手順を紹介します。 
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テクニカル サポートとリソース 

TestComplete に関する質問、問題、その他のお問い合わせについては、下記のフォームからサポート 

チームまでご連絡ください。 

➢ https://support.smartbear.com/message/?prod=TestComplete 

サポート チームから電子メールで回答を送付します。また、以後の連絡は電子メールで行われます。 

さらに、フォーラムで回答を探したり、意見を交換することもできます。また、よくある質問で質問に対する回

答を見つけたり、ビデオ チュートリアル、Web セミナー、ブログを見たり、テクニカル ペーパーを参照したり、

SmartBear 社による TestComplete トレーニング セミナーに参加することも可能です。 

開発元から提供されるサポート情報に関しては、次の Web サイトを参照してください。 

https://support.smartbear.com/ 

 

エクセルソフト株式会社へのお問合せ 

TestComplete に関する質問、問題、その他のお問い合わせについては、エクセルソフト株式会社の下記の

お問合せページからお気軽にご連絡ください。 

https://www.xlsoft.com/jp/services/xlsoft_form.html 

 

 

https://support.smartbear.com/message/?prod=TestComplete
https://support.smartbear.com/
https://www.xlsoft.com/jp/services/xlsoft_form.html?option2=SmartBear_TestComplete
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